
Retinal imaging control software NM 2
Version 3.2

Operation Manual

Make sure you read this manual before using the instrument.
Keep this manual safely so that you can use it in the future.
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This Operation Manual contains information necessary to operating and handling the Retinal imaging 
control software NM 2 (referred to as “Rics NM 2” in this manual), which is provided with the Digital 
Retinal Camera CR-2. Be sure to read this manual thoroughly before using the instrument, and apply 
the information that you learn.

Important
•	Before installing the Rics NM 2, you must read through the end user license agreement covering 

the terms and conditions under which the software is to be used.

Disclaimers
•	Canon takes no responsibility for damage that occurs due to fires, earthquakes, third party 

actions, other accidents, the user’s deliberate misuse, negligence, experimentation, or use under 
other abnormal conditions.

•	Canon takes no responsibility for direct or consequential damages resulting from the use or 
the inability to use the Rics NM 2. In addition, no compensation is available for lost image data, 
regardless of the cause of the loss of the image data.

•	Canon takes no responsibility for injuries or property damage that may occur if safety precautions 
are not followed or the instrument is used for something other than its intended purpose.

•	Medical examinations are the responsibility of a doctor. Canon takes no responsibility for 
diagnostic results.

•	 Follow the laws relating to the production, processing, analysis, and storage of medical images. 
The user is responsible for maintaining the confidentiality of image data.

•	Canon reserves the right to change the specifications and other aspects of the Rics NM 2 without 
prior notice.

•	Although we have made every effort to ensure the accuracy of the information in this manual, if you 
have any queries regarding the contents, please contact the Canon representative or distributor 
from whom you purchased the Rics NM 2.

Installation
•	Please ask the distributor or Canon representative where you made the purchase to install the Rics 

NM 2.

Trademarks
•	Canon and the Canon logo are trademarks of Canon Inc.

•	Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in 
the United States and/or other countries.

•	Other system names and product names that appear in this manual are trademarks of their 
respective companies.

Copyright
•	The copyright of this manual belongs to Canon Inc.

•	Unauthorized reproduction, duplication, or reprinting of this manual in whole or in part is 
prohibited.
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Before using the Rics NM 2, read these safety precautions for information about how to use the Rics 
NM 2 correctly. The cautions indicated here are to prevent injury or harm to users or other as well as 
property damage.

Conventions Used in This Manual
This manual uses the following symbols to indicate safety precautions that are important for using the 
Rics NM 2 safely. Always follow the advice in these safety precautions.

 CAUTION
A caution that incorrect operation may result in serious injury. 

CAUTION A caution that incorrect operation may break the Rics NM 2 or damage other 
products. 

This symbol indicates things that must not be done (prohibited actions). 

This symbol indicates things that must be done. 

This symbol indicates important advice that we strongly recommend be 
followed while operating the Rics NM 2. 

This symbol indicates supplementary explanations or advice for operating the 
Rics NM 2. 

Safety
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Safety

Safety Precautions

 CAUTION Make sure that the patient’s name, ID, birth date, and sex 
match those that are entered for the patient
If the entered information is in error, patients may be mixed up and misdiagnosed, 
which may result in physical injury to the patient.

CAUTION

Prohibited

While images are being transferred, never turn off the 
computer
Doing so might damage the hardware or corrupt the data.

Prohibited

Do not change the OS settings (e.g. screen resolution, date 
format, date, or language) while the Rics NM 2 is running
If changes are made while the Rics NM 2 is running, it may not function properly.

Prohibited

Do not operate the retinal camera while operating the Rics 
NM 2
Otherwise, the Rics NM 2 may not function properly.

Prohibited

After taking the image of the retina, do not operate the Rics 
NM 2 until transferring of the image is completed
Otherwise, the Rics NM 2 may not function properly.

Prohibited

While images are being transferred, do not turn off the retinal 
camera or disconnect the DC coupler of the digital camera 
and the USB cable between the PC and retinal camera
Doing so might damage the hardware or corrupt the data.

On the Change Patient Information screen, use care when 
editing the patient information
Regardless of all the essential data, input-disabled data and input format settings 
which were set on the Study Input/Manual Input tab screen, all the data can be 
changed and input. 
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Overview of Software

The Rics NM 2 imports retinal images taken with the Canon Digital Retinal Camera CR-2, and 
provides you with functions for browsing, processing, printing, saving, and comparing images. 

Features

Study input
•	Accepting input from keyboard, magnetic card, and barcode readers. 

•	Accepting input from worklist. 

•	Assigning accession numbers automatically. 

Taking images
•	Acquiring the retinal images and right/left eye information taken with the retinal camera. 

•	 Flash intensity and observation light brightness can be automatically adjusted.

Image display
•	 Full-screen view is possible.

•	Stereo photography and stereo view are possible.

•	Comparison with past images is possible.

•	Screens can be captured.

Image processing
•	Red, Green, Blue, digital Redfree, and digital Cobalt in color images can be displayed. 

•	C/D ratio (area, linear, verticalness) can be measured.

•	 Image adjustment (contrast, brightness, gamma, hue) is possible.

•	Processed images (generated images) can be saved.

Printing
•	Simple printing and multiple layout printing. 

Database
•	Managing and storing the study and patient information by individual studies. 

•	Study data on the database can be stored on DVD or external hard disk.

•	Externally saved study data can be imported.

Transferring and exporting images
•	Exporting to JPEG format file containing DICOM or study information. 

•	Simultaneously transferring studies to two destinations. You can specify DICOM storage servers 
and folders on the network as the destinations.

DICOM standard compliant
•	Study information can be acquired from HIS/RIS using Modality Worklist. 

•	Sending study status information to HIS/RIS with the MPPS function. 

•	Sending images to the DICOM storage server with DICOM Storage Service. 

1 Introduction
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Software Operating Environment
The Rics NM 2 runs under the following operating environment.
For details on the system, contact the Canon representative or distributor. 

Hardware or software Specifications

CPU Core 2 Duo 2.4 GHz or higher 

RAM 2 GB or more

Display
Screen resolution: WXGA (1280 x 800 pixels) or higher
Screen colors: 24 bits or more

Hard disk 3.5-inch 7,200 rpm or higher

Mouse Microsoft Mouse or compatible mouse

Interface
USB 2.0 (for communication between retinal camera and digital camera)
RS-232C (for magnetic card/barcode reader)

OS

Microsoft Windows 7 Professional
Microsoft Windows Vista Business SP1/SP2
Microsoft Windows XP Professional SP2/SP3
The Rics NM 2 does not support x64 (64-bit version).

Software 

Microsoft .NET Framework Version 3.5 SP1
SQL Server 2005 Express Edition SP3
Canon Easy-PhotoPrint EX Version 2.0.0 or later (for printing captured 
images)
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Notes on Use

Software
(1) The Rics NM 2 can be used only by users who belong to the following groups:

 Windows 7 / Windows Vista: Users or Administrators
 Windows XP:  Administrators

(2) The Rics NM 2 enables the retinal camera taking 30 images in a single study.

(3) In a Windows operating environment, be sure to set the access permissions for the storage folder in 
the following cases.
•	When exporting files to a destination set with the Storage Type of Export (DICOM) or Export 

(JPEG)

•	When changing the saving folder for the study management to a folder from the default folder 
(Installation folder\Database\Images)

•	When saving the temporarily saved study logs

•	When using a study file for list input (such as ccrhis.his)

In the Security tab under the folder Properties, give Modify permission to the Users group and Full 
control permission to the Administrators group.

(4) Use care with the following when saving the temporarily saved study logs or viewing the study log 
files.
•	To specify a folder on the network, get the access rights to the folder as the Windows login user. 

For details on the access rights on the network, contact the system administrator.

•	Do not set the password on the removable media (CD, DVD or flash drive etc.).

(5) Do not use the Switch User (where the user is switched without logging off) in Windows. When 
multiple users are using the Rics NM 2, be sure to select Log Off, and then log on again as a different 
user.

(6) Be sure to set the Screen saver, Power Options and Font settings as shown below.

Windows 7

Items Settings

Screen saver None

Turn off the display Never

Put the computer to sleep Never

Turn off hard disks Never

When I press the power button Shut down

Start menu power button Shut down

Font size Smaller - 100% (default)
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Windows Vista

Items Settings

Screen saver None

Turn off the display Never

Put the computer to sleep Never

Turn off hard disks Never

When I press the power button Shut down

Start menu power button Shut down

Font size Default scale (96 DPI)

Windows XP

Items Settings

Screen saver None

Turn off monitor Never

Turn off hard disks Never

System standby Never

When I press the power button on my computer Shut down

Enable hibernation Disable

Font size Normal

During the Windows shut down process, do not perform any of the following operations.
 Windows 7 / Windows Vista: Sleep
 Windows XP:  Standby

(7) If an application error appears, the Rics NM 2 freezes or the captured image does not appear during 
a study, take the following steps. 
1) Turn off the retinal camera and digital camera.
2) Turn off the PC.
3) Remove the DC coupler from the digital camera, and then re-insert it.
4) Turn on the PC.
5) After the OS starts up, turn on the retinal camera and digital camera.
6) Start up the Rics NM 2.

(8) To prevent a wizard or menu from automatically opening while the digital camera is connected to the 
Windows PC, take the following steps. 

Windows 7 / Windows Vista:
1) Open the Control Panel, and click Hardware and Sound and click Play CDs or other media 

automatically. 
2) Select Take no action from the dropdown list for Canon EOS 50D RETINA. Then, click Save. 

Windows XP:
1) Select Scanners and Cameras in the Control Panel.
2) Right-click Canon EOS 50D RETINA, then open the Properties screen.
3) Click the Events tab and select Take no action, then click OK.

(9) The Rics NM 2 does not support environment-dependent characters extended in Windows 7/
Windows Vista. 
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Digital camera settings
•	Do not change the digital camera settings. If the proper settings are not made, the camera will be 

unable to take images.

•	No CF card is used. Do not insert a CF card into the digital camera.

•	After turning on the digital camera or using menu buttons, "No card" and "Sensor cleaning" 
appear once on the digital camera's LCD display. This is not an error. 

Basic settings for the digital camera are shown below.

Items Settings

Shooting mode M (Manual exposure)

Expo. comp./AEB 0/Canceled

WB SHIFT/BKT 0,0/±0

Auto power off Off

Live View function settings
Expo. simulation

Disable

Live View function settings
Silent shoot

Mode 1



1 Introduction

13

System Configuration

With the Rics NM2, the CR-2 can be configured in a variety of systems – from a standalone setup 
through to a DICOM network environment. Examples of three typical configurations are shown below.

Example where the CR-2 System is not Connected to a Network
In this configuration, the CR-2 system is run as a standalone device. Patient information is input from 
the keyboard, and captured images are stored on the local hard disk as temporarily saved study logs. 
When the hard disk drive reaches its full capacity or the storage period of the study logs has elapsed, 
study data is saved on an external mirroring hard disk, DVD or other media as study log files. Study 
log files can be easily displayed, printed and compared with other studies whenever required. Up to 
100 study log files can be imported and used as temporarily saved study logs. Up to 3,000 patient 
input histories can be stored in memory, which allows patient information to be input easily. 

CR-2

USB

Rics NM 2
Temporarily 
saved study 
logs data

Study log 
files

Example of PC Network System
A configuration manages study data in an image filing system connected to the network in a 
hospital*. Study information is input from keyboard, magnetic cards or barcodes. A captured image 
is converted into a DICOM file or JPEG file that contains the study information and exported to a 
folder in the image filing system on the network. These files are input on the image filing system. The 
study data is stored for a fixed period as temporarily saved study log data, and it can be exported to 
another image filing system, viewed locally, printed and compared with other studies.

*  For details on the image filing system, contact the Canon representative or distributor from whom 
you purchased the CR-2. 

CR-2

USB

Rics NM 2
Temporarily saved 
study logs data

Image filing system

Images

Network

Export (DICOM/JPEG)
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Example of DICOM network system
In this configuration, the CR-2 system is connected to the DICOM network in a hospital. The worklist 
is acquired from HIS/RIS, and patient information is input for a selected study. Captured images are 
transferred and stored on the DICOM storage server. Study status information can be sent to the HIS/
RIS at the same time. Since study data is stored for a fixed period of time as temporarily saved study 
logs, it can be re-transferred to the DICOM storage server, transferred to a different image server, 
viewed locally, printed, and compared with other studies. 

CR-2

USB

Rics NM 2
HIS/RISDICOM storage 

server
Temporarily saved 
study logs data

Images

Saving images
Network

Worklist/Study progress management DICOM protocol
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Main Screen Elements

Main Screen Layout

1
2
3

7

8

9

4  

5  

6  

10 11
1 Menu bar
2 Toolbar
3 Study tab
4 Thumbnail image area
5 Image toolbar
6 Main image area

7 Patient information area
8 Study information area
9 Study description area
10 Study Cancel button
11 Study Complete button

1223

17 19 21 22201612 13 14 15 18

12 Retinal camera mode
 : Color

 : Red

 : Green

 : Blue

 : Digital Redfree

 : Digital Cobalt

 : Capture Screen

13 Image number (by time)

14 Right/left eye 
R: Right eye, L: Left eye, B: Screen capture image

15 Photography time
16 C/D ratio measurement mark
17 Stereo mark
18 Reject mark
19 Generated image mark
20 x2 mark
21 x2 image
22 Capture Screen mark
23 Patient ID



16

1 Introduction

Main Screen/Toolbar

Icon Icon name Description

Study Starts a new study.

Color Sets the color photography mode.

Capture Settings Makes the photography settings during a study.

Capture for Stereo View Sets the stereo photography mode.

Photography Ready Lamp
Green indicates that shooting is possible.
Red indicates that shooting is not possible.

Main and Thumbnails Displays main image and thumbnail images.

Two-Row Thumbnails Displays thumbnail images in two rows. 

Thumbnails Only Displays all thumbnail images.

By Time
Arranges the thumbnail images in the order they 
were taken.

By Retinal Camera Mode
Arranges the thumbnail images by retinal camera 
mode.

Compare Studies Compares the image with the study log image.

Stereo View Displays the stereo view.

C/D Ratio Measures the C/D ratio.

Print Prints images.

QA Performs image QA processing.

Reject Rejecting the image 

Capture Screen
Captures the screen for the currently active 
study.

Previous Study Changes a study to display in the study log 
screen.Next Study

Study Logs Displays study log list.

Logout Performs logout.
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Main Screen/Image Toolbar

Icon Icon name Description

RGB Channels
Displays the RGB color channels of the color 
image.

Normal View Returns to the color image view.

Red Displays the red component of the color image. 

Green
Displays the green component of the color 
image. 

Blue Displays the blue component of the color image. 

Digital Redfree
Sets the color image display to the digital Redfree 
mode. 

Digital Cobalt
Sets the color image display to the digital Cobalt 
mode. 

Contrast/Brightness Adjusts the contrast and brightness. 

Reset Contrast/Brightness Resets the contrast and brightness adjustment.

Loupe Enlarges an area of the image.

Hand Moves the image.

Save Saves the main image as generated image.

Image Property Displays the image properties.

Fit to Image Area Displays the entire main image. 

Zoom Out Zooms out the main image.

Zoom In Zooms in the main image.

% Display magnification Displays the magnification percentage.

Full Screen Displays the main image at full-screen size.
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Main Screen/Menu Items

Menu Submenu Key Description

File

Change Password... Changes the password of the login user. 

Print Adjustment... Adjusts the printing images.

Print
Prints images using the simple printing 
function.

Page Setup... Makes the page settings for Simple Printing.

Easy-PhotoPrint EX Starts up the Easy-PhotoPrint EX.

Save As... Saves images as a JPEG or TIFF file.

JPEG Settings... 
Sets the image quality and size of JPEG 
images.

Logout Alt+F4 Logs out of the Rics NM 2.

Edit

Select All Selects all images.

Select Same Mode Images Selects all images taken in the same mode.

Delete Generated Image Deletes generated images.

View

Hide Rejected Images
Toggles between view/hide of rejected 
images.

Hide Study Information
Toggles between view/hide of study 
information.

Full Screen Displays the main image at full-screen size.

Patient
Change Patient 
Information...

Displays the Patient Info Edit screen.

Study

Study F1
Displays the Study Input screen to start a 
new study.

Skip Study Input F5
Starts a study without inputting the study 
information.

Study Cancel (Close)
Cancels the study. (Closes the study on the 
study log screen.)

Study Complete (Transfer) F12
Ends the study. (Transfers the study on the 
study log screen. The F12 key function is 
disabled on this screen.)

Set Auto Numbering... Automatically assigns an accession No.

Next Study Space
Selects a study to display in the study log 
screen.Previous Study

Back 
Space

Capture

Capture for Stereo View... F6 Displays the stereo photography screen.

Capture Settings... F7
Makes the photography settings during a 
study.

Help Version Displays the software version information.
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Screen Flowchart

A screen flowchart is provided below for the process from the Rics NM 2 startup screen through to 
login, study input, capture of retinal image, completion of study, logout, and exiting the Rics NM 2. 

 

Start screen

Main screen

Study Input screen

Main screen 
(photography ready)

Login screen

Main screen (images appear)

Main screen (compare studies)

Study Complete screen

Exiting the 
Software

Main screen (logout) Login screen
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This chapter describes the basic operations of the Rics NM 2 from startup and input of the study 
information through to taking retinal images, browsing images, printing, ending the study, and exiting 
the software. For details on retinal camera operations, see the Operation Manual of the Digital Retinal 
Camera CR-2. 

The system settings below are required for the Rics NM 2:
•	 Installation

•	Environment setting that match the connected network and operation

•	 Login user registration

•	Devices and settings used for study information input

•	Saving procedures for images

The system settings must be made by a system engineer or service technician. For details on the 
settings, contact a Canon representative or distributor.

Starting up the Rics NM 2

Double-click the Canon CR-2 icon on the desktop.
After the startup screen appears for several seconds, the login screen appears. 

Logging In

Input the User ID and Password on the login screen, and click Login. If authentication is performed 
correctly, the login screen closes, and the main screen appears. 

2 Basic Operation
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Starting a Study

This section describes how to input study information manually. To input the information in another 
way (from a magnetic card/barcode, worklist, or study file), see "Inputting Studies" (on page 28). 
In this example, the Patient ID was selected as an essential item. For details on essential item 
settings, see "Study Input" (on page 101). 

 CAUTION Make sure that the patient’s name, ID, birth date, and sex match those 
that are entered for the patient
If the entered information is in error, patients may be mixed up and misdiagnosed, which may 
result in physical injury to the patient.

1 Click  button (Study) on the toolbar of the main screen. 
Or, select Study > Study F1 from the menu.

 

Study

2 Select the Manual Input tab on the Study Input screen.

Input the patient ID. Essential input items are indicated in blue. Data can also be input for other items.
 

Patient ID
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3 When input is completed, click OK. 

The Study Input screen closes. The study tab is added to the main screen, and the patient 
information appears on the right side of the screen. 
This screen is ready for starting the study. The retinal image can be captured.

 

Study tab

Patient ID



2 Basic Operation

23

Using Automatic Exposure (AE) for Intensity/Brightness Adjustment

Manual and automatic exposure (AE) can be selected for adjusting the observation light brightness 
and flash intensity. 
This section describes the procedure for setting the observation light brightness and flash intensity to 
automatic exposure (AE). 

1 Click  button (Capture Settings) in the main screen. 
Or, select Capture > Capture Settings F7 from the menu.
The Capture Settings screen appears. 

2 Select Yes under Auto Exposure for Shoot and Auto Exposure for Observation. 

The intensity indicator of the observation monitor for the retinal camera changes to ON.
 

Observation light 
brightness indicator 

Flash intensity indicator 

3 Click OK.

The Capture Settings screen closes. 



24

2 Basic Operation

Taking Images
To take retinal images, operate the retinal camera. For details, see the Operation Manual of the Digital 
Retinal Camera CR-2.

1 Input the study description to Study Description. 

The study description is applied for all images captured for the study. Input may be omitted, if it is not 
necessary. 

Photography 
ready lamp

2 Make sure that the photography ready lamp lights green. 

Images cannot be taken if the photography ready lamp is red. 

3 Press the shutter release button on the retinal camera. 

The retinal image data is captured, and appears on the main screen. 

To capture another image, repeat the procedure from step 2. 

Input comments for each image

Click  button (Image Property) to display the Image Property screen. Input the comment to 
Image Comments. 
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Viewing Images

This section describes how to view captured images in the main screen.

1 Click the thumbnail image to be viewed.

2 Click  button (Zoom In) or  button (Zoom Out).
Images can be zoomed in up to 100%. Turning the mouse wheel also changes the magnification. 
Click  button (Fit to Image Area) to display the entire image.

3 Select  button (Hand), and drag the image to move it. 
The image can also be moved by operating the scroll bars of the main image display area. 

Any changes made to the display magnification and display positions are kept when another 
image is selected.
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Printing Images (in Simple Printing)

1 Click the desired image on the thumbnail image area.

2 Click  button (Print).

Or, select File > Print from the menu. 
The Print screen appears. 

To assign simple printing to the Print button, see "Print" (on page 126).

3 Check that the desired printer is selected, and click Print.

Printing is started. 

Patient information is printed in the margins of the printout. 
The patient ID and accession number are each prefixed with "ID:" and "No.". 

 

Patient ID Patient name Accession number Photography date and time

Right/left 
eye
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Ending a Study

1 Click Study Complete.

Or, select Study > Study Complete F12 from the menu. 

2 Click OK in the Study Complete screen. 

Transfer of the study information is started.

An icon indicates the transfer status on the right end of the menu bar on the main screen. The icon 
disappears when transfer ends successfully. 

 

Transfer status icon

Transfer in progress
Transfer error

Logging Out

Click  button (Logout), or select File > Logout Alt+F4 from the menu. 
The main screen closes, and the login screen appears.

If there is a study in progress, the user cannot log out. Before logging out, be sure to end the 
study. 

Exiting the Rics NM 2

Click Exit in the login screen.
If the transfer icon appears, the Rics NM 2 cannot be exited until the transfer is completed. 
If the transfer error icon appears, re-transfer manually. For details, see "Transferring All Temporarily 
Saved Study Logs" (on page 75).

CAUTION While images are being transferred, never turn off the computer
Doing so might damage the hardware or corrupt the data.

Transfer status 
display position
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This chapter describes study operations: inputting studies using the worklist or study file, various 
image operation/processing, printing with Easy-PhotoPrint EX, measuring the C/D ratio, stereo 
photography, stereo view, and study log operations.
For details on retinal camera operations, see the Operation Manual of the Digital Retinal Camera CR-
2. 

Inputting Studies

There are four methods below for inputting studies:
1. Manual input: Input studies using the keyboard.
2. Magnetic card/barcode input: Input studies using the magnetic card/barcode reader.
3. Worklist input: Input studies using the worklist acquired from the worklist server.
4. List input: Input studies using study files containing the patient information in text format.

 CAUTION Make sure that the patient’s name, ID, birth date, and sex match those 
that are entered for the patient
If the entered information is in error, patients may be mixed up and misdiagnosed, which may 
result in physical injury to the patient.

Inputting Studies Using the Keyboard

1 Click  button (Study). 
Or, click Study > Study F1 from the menu. 
The Study Input screen appears. Click the Manual Input tab.

3 Advanced Operation
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2 Input the patient information.

The item names in blue are essential input data. 

Acceptable characters and input format for each item
•	 For details on the acceptable characters for each item, see "Acceptable Characters" (on page 142). 

•	 It is possible to set the header items of the history list. See Input-Disabled Data of “Study 
Input/Manual Input tab” (on page 102). 

•	 It is possible to select the input method of Birth Date. See Birth Date Input of “Study Input/
Manual Input tab” (on page 102). 

•	History list can display the Patient ID, Last Name, First Name, Middle Name, Prefix, Suffix, Birth 
Date, Sex, and Ethnic Group.

3 Click Search history list. 

History list displays only studies that match the search conditions. 

Sorting history list
Clicking an item on the title row of the history list sorts the list by the corresponding item. The initial 
click sorts the list in ascending order, and clicking it again sorts it in descending order. 
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4 Click a row on the History List to select a study. 

The patient information of the study in the history list is inserted into each item field in the top half 
of the screen. To input any additional items, input the item and click OK. The Study Input screen 
closes, then the main screen appears.

Study items
•	 For searchable items, an AND search is made with the patient ID and patient name (Last Name, 

First Name, Middle Name), and the search is based on the beginning of the search string. Partial 
text searches are not possible. 

•	To display the entire previous studies in the history list after performing a search, either close the 
Study Input screen and open it again, or make all of the search condition fields blank, and then 
click Search history list. 

•	To delete a row displayed in the history list, click the row that you want to delete to select it, and 
then press the Delete key. The displayed row itself disappears, but the study information remains 
saved. For this reason, each item field in the top half of the screen is not erased from the history 
list even if it is deleted from the display. 

•	Only studies having an exact match for all items – Patient ID, Last Name, First Name, Middle 
Name, Prefix, Suffix, Birth Date and Sex for the study which was input – are considered to be 
the same study. If any item is different, the study is treated as a separate study. 

The last 3,000 patient entries are saved in the history list. If the history exceeds 3,000 entries, the 
entries are automatically deleted starting from the oldest. 
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Inputting Studies Using the Magnetic Card/Barcode Reader
Data and communication settings must be made for using a magnetic card/barcode reader. 
For details, contact the Canon representative or distributor. 

1 Click  button (Study). 
Or, click Study > Study F1 from the menu. 
The Study Input screen appears. 

2 Click the Mag Barcode Input tab. 

3 Input the study information using the magnetic card/barcode reader. 

A search is made for the input items, and the results appear in the history list. 
If some items were already manually input, they are overwritten by the data from the magnetic card/
barcode reader. The item names in blue are essential input data. 

4 Input any items not input from a magnetic card/barcode reader using the keyboard. 

Check the input study information, and then click OK. 

If a magnetic card reader or barcode reader is not connected or the power is not turned on when 
the Mag Barcode Input tab is clicked, the Error screen appears. 

For details on the acceptable characters for each item, see "Acceptable Characters" (on page 142). 
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Inputting Studies from the Worklist
The Rics NM 2 can acquire worklists (scheduled study information) from a hospital information 
system (HIS) or radiology information system (RIS). Set the maximum number of worklists that can be 
acquired in a single operation on the Study Input/Worklist tab screen (on page 104). 
The Rics NM 2 can also notify the HIS/RIS of the study status. 

1 Click  button (Study). 
Or, click Study > Study F1 from the menu. 
The Study Input screen appears. Click the Worklist tab. 
The study list acquired from the worklist server appears. 

Worklist server searches
When Display Worklist Search window has been selected, the Worklist search screen appears 
automatically ahead of the Study Input screen. For further details, see "Study Input/Worklist tab" 
(on page 105).
For details on the Worklist search screen, see step 3.

Searches using a magnetic card/barcode reader
If a study is input from a magnetic card/barcode reader while the study list on the Worklist tab 
appears, a search of the worklist is performed again and the search results appear in a list. 
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2 To change the search conditions of the worklist server, click Search. 

The Worklist search screen appears.

3 Input the search conditions.

To search by Patient ID, for instance, select Patient ID from the Search Conditions: DICOM Tag 
Keyword list box, and input the ID on the right side. 

4 To return the search conditions to their defaults, click Default. 

For details on the default settings, see "Setting the Worklist Search Conditions" (on page 106).

5 Click OK. 

The Worklist search screen closes, and the worklist is re-searched. 

6 Select the study from the re-searched study list, and click OK. 

The main screen appears. 

Worklist search conditions
For a description of search date condition and search DICOM tag keyword settings, see “Setting 
the Worklist Search Conditions” (on page 106).

Changed search conditions
Among the changed search conditions, Patient ID, Patient Name, Accession No. and Requested 
Procedure ID are saved until either the Study Input screen is closed or switched to another 
screen. Other items are saved until either the software is exited or the worklist search conditions 
are changed. For further details, see “Setting the Worklist Search Conditions” (on page 106).
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Inputting Studies from the Study List
Study information can be input from a study file (ccrhis.his) that contains patient information. 
Up to 10,000 cases can be recorded in a study file. 
Study results can also be output to a study history file (ccrhis.hr). 

1 Click  button (Study). 
Or, click Study > Study F1 from the menu. 
The Study Input screen appears. 

2 Click the List Input tab.

3 Select a study from the study list, or if there are too many studies in the list, proceed 
with a search. 

Click Search. The Setting Search Conditions screen appears. 
Input the search items. The magnetic card/barcode reader also can be used to input items. 

For details on the acceptable characters for each item, see “Acceptable Characters” (on page 142). 

4 Click OK. 

The search results appear on the Study Input screen. 

5 Select a study, and then click OK. 

The Study Input screen closes, then the main screen appears.
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Correcting Patient Information
The patient information of the current study that was input manually or with a magnetic card or 
barcode reader can be corrected. Patient information acquired by list input or worklist input cannot 
be changed.

1 Click Patient > Change Patient Information... from the menu. 

The Patient Info Edit screen appears. 

2 Correct the patient information.

3 Click OK to close the Patient Info Edit screen. 

CAUTION On the Change Patient Information screen, use care when editing the 
patient information
Regardless of all the essential data, input-disabled data and input format settings which were set 
on the Study Input/Manual Input tab screen, all the data can be changed and input. 
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Canceling Studies
Studies can be canceled, for instance, when a study is to be canceled midway or there is no need to 
save images that have been captured. 

1 Click Study Cancel. 

2 Click OK in the Study Cancel screen. 

The study is canceled without saving the images that have been captured. 

Canceling a study
The same Study Cancel screen appears even when there are no captured images. To cancel a 
study, click OK. 
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Interrupting One Study to Conduct Another Study
A study in progress can be interrupted to conduct another study. The studies of up to three patients 
can be kept open on the main screen. 

1 Click  button (Study). 
Or, click Study > Study F1 from the menu. The Study Input screen appears. 

2 Input the patient information on the Study Input screen, and click OK to close the 
screen. 

3 Proceed with taking retinal images using the added study tab. 

To resume the previous study, click the study tab to switch the study. 

Added study 
tab
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Capturing Images before Completing Study Information
Retinal images can be taken without first opening the Study Input screen.
When the study is completed, input the information and save the image. 

When automatic numbering function is used, Skip Study Input function cannot be used.

1 Click Study > Skip Study Input F5 from the menu. 

A blank study tab is added on the main screen.

2 After the retinal images have been taken, click Study Complete. 
 

Study tab

3 Input the patient information on the Study Input screen. 

Click OK to close the Study Input screen. 
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Image Display

Changing the View Mode of the Main Screen
Three view modes can be selected by  button (Main and Thumbnails),  button (Two-Row 
Thumbnails) and  button (Thumbnails Only). 

Changing the Display Sequence
The sequence in which thumbnail images appear can be selected using  button (By Time) or  
button (By Retinal Camera Mode). Each click of the button toggles between ascending or descending 
order. The display sequence in the same retinal camera mode can be changed on the Screen/
Thumbnail Order tab screen (on page 123).

 

By Time By Retinal 
Camera Mode
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Displaying in the Full-Screen Mode
The image appears at full-screen size when the main screen or the RGB channel view image is 
selected. You cannot take a retinal image when an image appears in the full-screen mode.

1 Click the thumbnail image to be browsed. 

Or, click  button (Full Screen). 
The main image appears in the entire screen. 

2 Move the mouse to the region to be zoomed in, and roll the mouse wheel away from 
you. 

The image is enlarged up to 100% centering on the mouse position. Rolling the mouse wheel towards 
you zooms out of the image. Zoom in and zoom out can also be performed by clicking  button (Zoom 
In) and  button (Zoom Out), respectively.  
Click  button (Fit to Image Area) to display the entire image.

Display 
magnification

Fit to Image 
Area

Mouse cursor



3 Advanced Operation

41

3 Select  button (Hand), and drag the display position of the image to move the image. 
Images can also be moved by dragging the scroll bars.

4 Click  button (Return).
The main screen re-appears. The same operation can be performed by pressing the ESC key. 

Changing images
If there are two or more thumbnails, press the right or left arrow key to change the images.

Magnifying Images Using the Loupe
Any part of the main image can be magnified. 

1 Click  button (Loupe). 
The mouse cursor changes shape to a loupe. Move the mouse to the position to be magnified. 

 

Mouse cursor

Loupe

2 Click a part of the main image. 

The part is magnified and appears. When the mouse is dragged, the magnification position moves as 
well. To change the magnification size and ratio, see “Screen/Loupe tab” (on page 124).

 

Magnified 
area
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Rejects
The reject mark can be assigned to images that have failed to be captured or images that do not 
need to be saved. These images will not be transferred when the studies are completed. 
Images with the reject mark can also be hidden. 

Rejecting Images
Click the thumbnail image, and click  button (Reject). The reject mark will appear at the bottom 
right of the image. 

Reject 
button

Reject mark

Hiding Rejected Images
Click View > Hide Rejected Images from the menu to select this item. Images with the reject mark 
are hidden, and  button (Reject) is also disabled. 

Canceling Rejects
To cancel rejects, click View > Hide Rejected Images from the menu to clear the checkbox first. 
Then, click the rejected image, and click  button (Reject). 
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Inputting Image Comments
Image comments can be attached to images. 

1 Click  button (Image Property). 
The Image Property screen appears.

 

Image Property

2 Input comments for the image. 

A comment consisting of up to 4,096 characters can be input.

To browse other items on screen, double-click the item name. The screen for the double-clicked 
item appears.
Click Close to close the screen.

3 Click OK to save the image comment. 
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Image Processing
This section describes contrast/brightness adjustment, RGB channel view, digital color filtering, 
quality assurance (QA), and screen capture. Digital color filtered images and screen capture images 
are treated as generated images. 

Up to 30 generated images can be saved to a single study. To delete generated images, select 
Edit > Delete Generated Images from the menu. 

Adjusting the Contrast/Brightness
The contrast and brightness of the main image can be adjusted. 

1 Click the thumbnail image. 

2 Click  button (Contrast/Brightness).
The mouse cursor changes to one for adjustments. When the mouse button is clicked on the main 
image and then dragged up or down, the brightness (B) can be adjusted, and when it is dragged to 
the left or right, the contrast (C) can be adjusted. 

Contrast/Brightness

Reset Contrast/
Brightness Save

C: Contrast
B: Brightness

Mouse cursor 
(for adjustment)

To return to the image before adjustment, click  button (Reset Contrast/Brightness). 

The brightness and contrast values are retained for each image but they are not applied to the 
thumbnail displays, printed images or saved images. In addition, the adjustment values are reset 
when the Study tab is closed. 

3 To save the image after adjustment, click  button (Save). 
The adjusted image is added to the thumbnail image area. The contrast and brightness of the original 
image do not change. 
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Displaying the RGB Channel View
The color components (R, G, B) of the color image appear separately. This feature cannot be applied 
to captured images. 

1 Click the thumbnail of the color image.

2 Click  button (RGB Channels).
In addition to the color image, the R (red), G (green), and B (blue) color component images also 
appear. 
To restore to the original display, click  button (Normal View).

RGB 
Channels

Normal 
View

Color 
image

Blue image

Green image

Red image

The following image operations are available on RGB channel view images:
•	Zooming

•	 Full-screen display (on page 40)

•	 Loupe (on page 41)

•	Contrast/brightness adjustment (on page 44)

•	Moving the displayed area

Whenever the zooming in/out and moving operations are used, they are applied to all split-screen 
images. Contrast/brightness adjustment can be performed on individual split-screen images, and 
reset is applied to all split-screen images. 
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QA (Quality Assurance)
The contrast, brightness, gamma and hues of the images can be adjusted.

1 Click the thumbnail image. 

To select two or more images, click the images while holding down the Ctrl key, or to select a range 
of images, click the images while holding down the Shift key. 

Quality assurance (QA) is not possible in the following instances:

•	When the captured image and generated image are selected.

•	When different types of generated images are selected.

2 Click  button (QA).
The QA (Quality Assurance) screen appears. 

3 Set the adjustment parameters.

Set the parameters using one of the following methods:
•	Drag the slider.

•	 Input a numerical value in the text box on the right side.

•	Click the  button or the  button to specify a value.

Contrast and hues can be adjusted in the range of ±100, brightness can be adjusted in the range of 
±150, and gamma can be adjusted in the range of 0.01 to 3.00. If the Coordinate Hues checkbox is 
cleared, each individual hue can be adjusted separately. 

To return the parameters to the saved settings, click Restore Defaults.
To apply these parameters to the images in the same retinal camera mode, click Set as Default. 
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QA parameter sets

•	A set of parameters can be assigned a name and saved as a parameter set. Enter the name in 
the Parameter Set field, and click Add. 

•	To apply a previously saved parameter set to the currently displayed image, select the set from 
the Parameter Set list box. 

•	Names consisting of 32 characters or less can be assigned to parameter sets, and up to 10 
parameter sets can be saved. 

•	To overwrite an existing parameter set with the current settings, click Update, and to return to 
the saved settings, click Undo. 

•	To delete a saved parameter set, click Delete. 

4 Click Apply to Selected Images.

5 Check the message on the Warning screen, and click OK.

The QA (Quality Assurance) screen closes, and the parameters are applied.

Images for which quality assurance (QA) has been performed

•	When quality assurance (QA) is performed, the adjustments are applied to the thumbnail 
images. 

•	Changes by quality assurance (QA) are applied in printed images.

•	Quality assurance (QA) is applied to the transferred images. 

Generated images for which quality assurance (QA) has been performed
Contrast, brightness and gamma for generated images can be adjusted.
After setting the adjustment parameters, click Apply to Selected Images.
Click Reset to return to the values when the QA (Quality Assurance) screen was opened.
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Using Digital Color Filters
Digital filtering can be applied to color images, and color images appear in red, green, blue, digital 
redfree, or digital cobalt mode. 

1 Click the thumbnail of the color image.

2 Click the desired digital color filter button.

The digital color filtered image appears. 

Red

Green

Blue

Digital Redfree
Digital Cobalt

3 Click  button (Save).
The digital color filtered image is added to the thumbnail image area. 

The digital color filter is applied to only color images and cannot be applied to captured images. 

About Digital Redfree and Digital Cobalt 
Digital color filtering is applied to color images to reproduce an image as though it was taken with 
an optical filter. 
This means it is not the same as Redfree images and Cobalt images taken using an optical filter. 
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Capturing Screen
The screen of the current study can be added as a study image. 
The following screen components can be captured as a captured screen. 
•	Main screen

•	Capture for Stereo View screen and Stereo View screen

•	C/D Ratio screen

•	RGB channels/Red/Green/Blue/digital Redfree/digital Cobalt mode screen

When  button (Capture Screen) is clicked, the entire currently displayed screen is captured and the 
captured image is added to the thumbnail image area. 

 

Capture Screen
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Printing
There are two printing modes available: simple printing and Easy-PhotoPrint EX. One of these printing 
types can be allocated to the Print button through the Settings Menu (on page 126). Select Print with 
Easy-PhotoPrint EX to print a multiple number of images on a single sheet. 

To print with Easy-PhotoPrint EX, install the software in advance.

Using Simple Printing
Clear the Print with Easy-PhotoPrint EX checkbox at the Print Screen in the Settings Menu. 

1 Click the thumbnail image to be printed.

2 Click File > Page Setup from the menu.

The Page Setup screen appears.

3 Select the paper size, paper source and printing orientation, and set the margin values 
(Left, Right, Top, and Bottom). 

Click OK to close the screen. 

4 Click  button (Print).
The Print screen appears. When Print with Easy-PhotoPrint EX under When Print icon is clicked 
is selected (on page 126), select File > Print from the menu. 



3 Advanced Operation

51

5 Check the settings made in the Print screen, and click Print. 

The print layout is as shown in the figure below.

Patient ID Patient name Accession number Photography date and time

Right/left 
eye

Using Easy-PhotoPrint EX to Print Images
Select the Print with Easy-PhotoPrint EX at the Print Screen in the Settings Menu. 
With Easy-PhotoPrint EX, you can use many different kinds of print layouts. To print study information, 
select any of the sheet sizes and layouts indicated in the table.

Paper size Layout Study information

4" x 6", 5" x 7" DICOM Info (x1), DICOM Info (x2)

Retinal camera model name, Patient 
ID, Accession No., Patient Name, 
photography date and time, R/L, 
Timer, file name*, image size*

A4
DICOM Info (x1), DICOM Info (x2), DICOM 
Info (x3), DICOM Info (x4), DICOM Info (x6), 
DICOM Info (x9), DICOM Info (x28)

LTR
DICOM Info (x1), DICOM Info (x2), DICOM 
Info (x3), DICOM Info (x4), DICOM Info (x6), 
DICOM Info (x9), DICOM Info (x24)

*  The file name and image size are printed only when A4 or LTR is selected for Paper Size and 
DICOM Info (x3) is selected for Layout. 

1 Click the thumbnail image to be printed.

To select two or more images, click the images while holding down the Ctrl key. 
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2 Click  button (Print). 
The Easy-PhotoPrint EX screen appears. When the Print button is set to Simple Printing, select File 
> Easy-PhotoPrint EX from the menu. 

3 On the Select Images tab, set the number of copies for each image.

4 Click the Select Paper tab, and select Paper Size and Media Type. 
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5 Click the Layout/Print tab, and select the print layout. 

To print study information, click an option starting with "DICOM Info". 

6 Click Print. 

Printing is started. After printing is completed, click Exit. The Easy-PhotoPrint EX screen closes, 
and the main screen re-appears.

Adjusting the Printing Parameters
The contrast, brightness, gamma, and hue of printed images can be adjusted. 

1 Click the thumbnail image. 

2 Click File > Print Adjustment from the menu. 

The Print Adjustment screen appears. 

3 Set the parameters by moving the sliders or changing the numbers in the fields at the 
right. 

The adjustment range is ±50 for Contrast, Brightness and Hue, and ±1.00 for Gamma. 

4 Click OK to save the settings. 
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Measuring the C/D Ratio

You can measure the cup-to-disc (C/D) ratio of the optic nerve papillary area from the retinal image. 
The following three methods are available:

Area ratio: Area ratio of cup part to the optic nerve papillary 

Line ratio: Ratio of diameter of cup in the disc at any angle 

Vertical ratio: Ratio of diameter of cup in the disc at a vertical angle 

Displaying the C/D Ratio Screen

1 Select the thumbnail image, and click  button (C/D Ratio). 
The C/D Ratio screen appears. 

2 Point the mouse cursor to the center of the optic nerve papillary area, and roll the mouse 
wheel away from you. 

The image is enlarged with the mouse cursor position as the center. Rolling the mouse wheel towards 
you zooms out of the image. Zoom in and zoom out can also be performed by clicking  button (Zoom 
In) and  button (Zoom Out), respectively.  

Enlarging the image on the C/D Ratio screen
When measuring the C/D ratio for the first time, click any C/D ratio measurement button. The 
mouse cursor changes to the Zoom In tool. Click the optic nerve papillary area with mouse cursor 
to enlarge the image as the size set on the Screen/C/D Ratio tab screen (on page 124).
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3 After clicking  button (Hand) to change the mouse cursor to  (Hand), drag the optic 
nerve papillary area to the center of the screen. 

You can also move the image by operating the scroll bars. 

Changing the C/D Ratio Measurement Settings

1 Click Settings.

The C/D Ratio Settings screen appears. 

2 Change the color of the line to draw. 

Click Disc Color or Cup Color to display the Color screen. Select the desired color. 
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3 Change the line weight and font size in the measurement results.

Either click the  button or the  button, or input numerical values directly. 

4 Click OK. 

The C/D Ratio Settings screen is closed, and the new settings are reflected. 
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Measuring the C/D Area Ratio
Draw closed curves on the retinal image to obtain the area ratio of the disc and cup. 

1 Click  button (C/D Ratio – Area). 
The mouse cursor changes to the Pencil tool. When the mouse cursor appears as  (Hand), click 
C/D Ratio first. 

2 Click the start point of the disc periphery on the image to start drawing. 

3 Click at least three points on the disc periphery and double-click to end drawing. 

A closed curve is drawn. Right-clicking and selecting Form a Shape from the menu also completes 
drawing of the closed curve. To delete the last selected point during drawing, press the BackSpace 
key. 
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4 Check that Cup is selected, and draw the cup periphery using the same procedure as 
for the disc. 

Draw the cup periphery in the same way as for the disc periphery. When drawing of the cup and disc 
is completed, the measurement values appear at the bottom left of the screen. 

Area Ratio
A. : 0.41
V. : 0.70
H. : 0.60

5 After drawing is completed, edit each curve.

•	Moving dots: Point to a dot and drag it to the desired position.

•	Deleting dots: Point to a dot, right-click and select Delete the Dot.

•	Adding dots: Point to a point on the line, right-click and select Insert the Dot.

•	Deleting all dots of a drawn disc or cup: While drawing a line, right-click and select Reset Disc or 
Reset Cup of Reset Drawing from the menu. After drawing lines, right-click and select Delete 
Objects from the menu. 

6 Click OK. 

The drawing information and measurement values of the C/D ratio are saved, and the screen closes. 
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Measuring the C/D Line Ratio
Draw straight lines of any angle on the retinal image to obtain the line ratio of the disc and cup.

1 Click  button (C/D Ratio – Line). 

2 Click twice on the disc periphery of the image. 

A straight line is drawn connecting the clicked points. 

3 Click twice on the cup periphery of the image. 

A straight line indicating the cup is drawn. The measurement results appear at A.L at the bottom left 
of the screen. 

Line Ratio
A. L: 0.67

4 After drawing is completed, edit each line. 

•	Moving dots: Point to a dot and drag it to the desired position.

•	Deleting all dots of a drawn disc or cup: While drawing a line, right-click and select Reset Disc or 
Reset Cup of Reset Drawing from the menu. After drawing lines, right-click and select Delete 
Objects from the menu. 

5 Click OK. 

The drawing information and measurement values are saved, and the screen closes.
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Measuring the C/D Vertical Ratio
Draw vertical lines on the retinal image to obtain the vertical line ratio of the disc and cup.

1 Click  button (C/D Ratio – Vertical Line). 

2 Click twice on the disc periphery of the image. 

A vertical line is drawn connecting the clicked points. 

3 Click twice on the cup periphery of the image. 

A vertical line indicating the cup is drawn. The measurement results appear at V. L at the bottom left 
of the screen. 

Line Ratio
V. L: 0.65

4 After drawing is completed, edit each line. 

•	Moving dots: Point to a dot and drag it to the desired position.

•	Deleting all dots of a drawn disc or cup: While drawing a line, right-click and select Reset Disc or 
Reset Cup of Reset Drawing from the menu. After drawing lines, right-click and select Delete 
Objects from the menu.

5 Click OK. 

The drawing information and measurement values are saved, and the screen closes.
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Re-editing Saved C/D Ratios
For the C/D ratio measured image before ending a study or that of temporarily saved study log, you 
can reedit the C/D ratio for updating measurement values or start additional measuring.

1 Select the thumbnail image whose C/D ratio was measured, and click  button (C/D 
Ratio). 

The C/D Ratio screen appears. 

C/D ratio 
measurement mark

2 Enlarge the image for editing easily. 

Point the mouse cursor to the optic nerve papillary area and roll the mouse wheel away from you to 
enlarge the image. Move the optic nerve papillary area to the center of the screen with the scroll bars 
or  button (Hand).

3 Point the mouse cursor to the line to edit and click it.

The dots appear on the line to be edited.
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4 Change a dot position.

Drag a dot to change the position. Each time a dot position is changed, the measurement values are 
updated. To change the color or weight of the lines, right-click and select Object Drawing Settings 
from the menu. The Object Settings screen appears. Change the desired settings. 

5 Edit the line again or another line.

Repeat the procedure from step 3.

6 Click OK. 

The Warning screen appears. Check the instruction in the screen and click OK. The drawing 
information and measurement values are saved and the screen closes. 
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Stereo Photography/View

This section describes the following functions relating to stereo photography/view:
•	Taking stereo photographs

•	Displaying stereo images

•	Registering individual captured images as stereo images

•	Canceling stereo image pairs

Set use of the stereo guide mark on the Retinal Camera/NM Settings tab screen (on page 98). 

Taking Stereo Photographs
Two retinal images shifted from the center to the ear and nose sides are taken for a stereo image. You 
will use working dots projected on the cornea to shift the image area. The shift amount is about 2.5 
mm of the baseline on the pupil. 

1 Click  button (Capture for Stereo View). 
Or, select Capture > Capture for Stereo View F6 from the menu. 
The Capture for Stereo View screen appears. First, take the left side stereo image. 

Indicates the 
side of image 
to be taken
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2 Take the left side stereo image.

1. Align the position of retinal camera with the target anterior eye, and press the alignment button to 
switch to retinal observation. The stereo guide mark appears on the observation monitor of the 
retinal camera. 

2. Tilt the operation lever to the left to put the flashing working dot on the left side into the stereo 
guide mark. 

3. Make sure that the photo ready lamp is green, and then press the shutter release button. 

Photography ready lamp Stereo guide mark (green)

Working dots Stereo mode Indicates the side of 
image to be taken

Put the flashing working dot 
into the stereo guide mark. 

The left side stereo image appears on the left side of the Capture for Stereo View screen. 

To take the left side stereo image again, click the left side of the screen. The light green bar 
displayed on the right side moves to the left side. 
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3 Take the right side stereo image.

The guide mark on the observation monitor of the retinal camera moves to the left side. The working 
dot starts flashing on the right side, outside the display range. Tilt the operation lever to the right 
to put the flashing working dot into the stereo guide mark. Make sure that the photo ready lamp is 
green, and then press the shutter release button. 

Stereo guide mark (green)

The right side stereo image appears on the right side of the Capture for Stereo View screen. To take 
the image again, click the side of the image to be taken, and then take the image. The previous image 
will not appear. However, all the images will remain in the thumbnail image area. 
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4 Click OK. 

The Capture for Stereo View screen closes, and the main screen re-appears.
Since the retinal camera is still in the retinal observation mode, press the alignment button to return it 
to the anterior observation mode. 

Stereo mark

The retinal camera does not return to the anterior observation mode after retinal observation even 
if Change Focus to Anterior After Every Exposure on the Retinal Camera/NM Settings tab 
screen is set to Yes. 
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Displaying Stereo Images
This section describes how to display the left and right images taken in stereo photography side by 
side. A stereo mark appears on the thumbnails of stereo images. 

1 Click the thumbnail image with a stereo mark. 
 

Stereo mark

2 Click  button (Stereo View). 
The Stereo View screen appears. 

Zoom In tool

3 Move  (Zoom In tool) to the center of the position to enlarge and click. 

The image is enlarged with the clicked position as the center. The mouse cursor changes shape to  
(Hand). 

To individually fine-adjust the position, click  button (Move/Apply Effects to Both Images) to cancel 
the linked movement of the images and drag the image. 

4 Click Close.

The Stereo View screen closes, and the main screen re-appears. 
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Registering Individually Captured Images as Stereo Images
Images captured in modes other than stereo photography can be registered as stereo images as 
long they satisfy the following conditions:
•	The photography mode, left/right eye direction and image size must all be matching.

1 Click the thumbnail of the first image. 

In this example, let's select shot No.5. 

2 Click the second thumbnail image with the Ctrl key held down. 

In this example, let's select shot No.7. 

3 Click  button (Stereo View). 
The Stereo View screen appears. The images line up into order which appears in the thumbnail 
image area.

4 Check the side-by-side alignment of the left and right images, and click Pair. 

To switch the left and right images, first click  button (<-->) and then click Pair. The two images 
displayed are registered as stereo images. 



3 Advanced Operation

69

5 Click Close.

The Stereo View screen closes, and the main screen re-appears. The stereo mark appears on the 
thumbnail images.

Stereo mark

Canceling Stereo Image Pairs

1 Click the thumbnail image with a stereo mark. 

2 Click  button (Stereo View). 
The Stereo View screen appears. 

3 Click Cancel Pair.

The stereo pair is canceled. 
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4 Click Close.

The Stereo View screen closes, and the main screen re-appears. The stereo mark disappears from 
the thumbnail images. 
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Study Logs

You can browse completed studies (past studies) on the Study Logs screen. The Rics NM 2 
classifies past studies either as a temporarily saved study log or as a study log file. When a study is 
completed, it is first saved as a temporarily saved study. Study data exceeding the storage capacity 
or storage period limit can be moved to another storage medium as a "study log file." 
The temporarily saved study log data contains the following types of data:
•	Transferred study data

•	 Failed transfer study data

•	Untransferred study data

The untransferred or failed transfer study data can be transferred or re-transferred to a registered 
storage device by initiating a Transfer All operation.

Displaying a List of Temporarily Saved Study Logs

1 Click  button (Study Logs). 
The Study Logs screen appears. 

2 Click the Temporarily Saved tab. 

The results searched using the study conditions that were set appear (on page 106). 
The studies can be sorted in ascending or descending order each time one of the item names is 
clicked. The column width of each item can be adjusted by dragging the divider line between each 
column. To add or delete display items, or change their display order, see "Setting the Display Items 
on the Study Logs Screen." 

Item name

Transfer in progress

Transfer Completed

Transfer Error

Blank Not transferred
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Searching for a Study Log

1 Click Search. 

The Search screen appears. 

Search button

2 Set the search conditions. 

The earliest date and/or latest date can be set to limit the date range for Study Date. To set only 
either of the dates, clear the checkbox of the date setting field that you do not need. Select Patient 
ID, Accession No., Patient Name or Study Description for Condition: Item. Search condition of the 
study date that has been set is retained until logout. 

Set a date range. 

Select an item. 

Input a keyword for 
the selected item. 

Apply the default setting. 

Initializing the study date
When Default is clicked, the settings of "Study Log" are applied to the Study Date field (on page 126). 

3 Click OK. 

The search is initiated, and the search results appear on the Study Logs screen. 

Search conditions of the study logs
Patient ID is searched with perfect matching.
Accession No. and Patient Name are searched with prefix matching. Study Description is 
searched with partial matching.

Number of displayed study logs in list
Up to 10,000 study logs appear in the list. A flashing error icon (  mark) appears when the 
number of matched study logs exceeds the limit. If so, change the search conditions to narrow 
down the results. The error icon disappears once the number of study logs is within the 
displayable range. 
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Displaying Temporarily Saved Study Logs

1 Click the Temporarily Saved tab. 

2 Double-click a study or select one, and then click OK. 

The main screen appears, and the image in the study log appears. The study log mark appears on 
the study log image. 

Study log mark

3 Click Close to exit the screen. 

To continue displaying other study logs, perform the following:
•	To display the next study (i.e. previous study): Click the Next/Previous Study button.

•	To display a specific study log: Click the Study Logs button to display the study logs list. 
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Number of study logs that appear
Only one study appears from the study logs list. 

Editing study descriptions
Study descriptions of temporarily saved study logs can be edited in the main screen. 
Changes to study descriptions can be saved by the following operations:

•	Next/Previous Study button, Study Logs button, Transfer button, or Compare Studies button

 When the Automatic Updates of Study Description screen appears, click OK.

•	Close button

 The Warning screen appears. Click Yes.

Adding generated images
You can add the generated images to temporarily saved study logs and save them.
•	Close button

 The Warning screen appears. Click Yes.
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Transferring All Temporarily Saved Study Logs
You can transfer all temporarily saved studies whose transfer status is transfer error or untransferred, 
at once. 
Note that already transferred studies are not transferred. 

Click the Temporarily Saved tab on the Study Logs screen, then click Transfer All. 

Untransferred 
study

Transfer error 
studies

•	 If there are studies whose transfer status is in error, the Re-Transfer Study(ies) of Failed Transfer 
screen will appear. Click OK. This screen will not appear if there are no studies whose transfer 
status is transfer error. 

•	 If there are untransferred studies, the Transfer all the untransferred study(ies) screen will 
appear. To change the storage device, click Select Storage, and to proceed the transfer without 
changing the storage device, click OK. 
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Transferring Temporarily Saved Study Logs
You can select and transfer temporarily saved study logs. 
As a study is re-transferred, the DICOM information for these studies will be updated. For further 
details, see "DICOM Tag/Study Logs tab" (on page 119).

1 Click the Temporarily Saved tab. 

2 Click a study (studies) to transfer. 

To select two or more studies, click the studies while holding down the Ctrl key, and to select a range 
of studies, click the studies while holding down the Shift key. 

3 Click Transfer. 

The Transfer the study(ies) screen appears. Click OK. 
A study for which a transfer is in progress cannot be transferred, and the attempt results in the 
Warning screen. 

To change the storage device, click Select Storage. The Select the Storage(s) screen appears. 
Select the desired storage device, and click OK. 
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Saving Temporarily Saved Study Logs
Temporarily saved study logs data can be saved in any folder on a study-by-study basis. Proceed to 
save the data in the following cases:
•	When there is not enough free space on the hard disk where the temporarily saved study logs 

data is saved

•	When you want to save temporarily saved study logs data, that have been kept beyond its storage 
period

•	When the number of temporarily saved study logs data has increased and more time is required to 
display a list or conduct a search

Saved studies appear on the Study Log Files tab. For details, see "Displaying Studies in the Study 
Log File" (on page 80).

To save a study log data, appropriate access rights for the storage folder must be set. For further 
details, see "Software" (on page 10).

1 Click the Temporarily Saved tab on the Study Logs screen. 

2 Select the study to be saved, and then click Save. 

To select two or more studies, click the studies while holding down the Ctrl key, and to select a range 
of studies, click the studies while holding down the Shift key.

When calculation of the space required for storing the study data is completed, the Save screen 
appears. 
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3 Click OK. 

The study data is saved. After the data is saved, the Study Logs screen re-appears. 
The Error screen appears if there is not enough free space or if the length of the path of the storage 
folder consists of more than 150 characters. 

Changing the save destination folder
To select a new save destination folder or to change the save destination folder, click Folder. The 
Browse For Folder screen appears. Select the new save destination folder in this screen. 
This software saves the storage folder information. However, if the Rics NM2 cannot access the 
destination folder when opening it – for example, when the media has not been inserted into the 
drive – the Rics NM2 will specify the desktop as the storage destination. 

Canceling saving of studies
Click Cancel to cancel saving of studies. Once Cancel is clicked, the Rics NM 2 quits saving of 
unsaved studies. However, studies that have been saved or that are being saved are saved to the 
designated save destination folder. 

Save destination folder
To specify a network shared folder as Destination to Save, proceed with "Map Network Drive". 
When a folder is "mapped" or allocated as a drive, the amount of free space appears. 

Temporarily saved study logs data that has been saved
Even if temporarily saved study logs data has been saved as study log files, the original temporarily 
saved study logs data is not deleted. To delete this data, see “Deleting Study Log Files” (on page 82).
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Deleting Study Logs
You can delete temporarily saved study logs.

1 Click  button (Study Logs). 
The Study Logs screen appears. 

2 Select the study to be deleted. 

To select two or more studies, click the studies while holding down the Ctrl key, and to select a range 
of studies, click the studies while holding down the Shift key.

3 Click Delete.

The Warning screen and the "Selected study will be deleted." message appear. Click OK to delete 
the study. However, if the transfer status is “Transfer”, the study concerned cannot be deleted. 

Setting the Display Items on the Study Logs Screen
On this screen, add or delete the items displayed on the temporarily saved study logs list, or set the 
display sequence of these items. 

1 Click  button (Study Logs). 
The Study Logs screen appears. 

The column width of each item can be adjusted by dragging the divider line between each column. 

2 Click Edit List.

The Edit List screen appears.

To change the display items, proceed as follows:
•	To add an item, select the item in Hidden Items, and click the  button. 

•	To delete an item, select the item in Displayed Items, and click the  button. 

•	To change the display sequence, select the item, and then click the Up button or Down button to 
move the item. 

3 Click OK to enable the settings. 
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Displaying Studies in the Study Log File
Studies stored in any of the folders or on a removable storage media, for instance, appear. 

1 Click  button (Study Logs). 
The Study Logs screen appears. 

2 Click the Study Log Files tab. 

The study file is read from the specified folder, and the study list appears. To change the display item 
of the study list, see “Setting the Display Items on the Study Logs Screen.”

Specifying the folder
To browse for other folders, click Folder, and specify the location on the Browse For Folder 
screen. 

Changing the search conditions of the study list
To change the search conditions of the study list, see “Searching for a Study Log” (on page 72). 

Display items
Display items set on the Edit List screen appear (on page 79). Note, however, that Transfer 
Completion Datetime and Study Trans Status cannot be set to display in the list. 

On the Study Log Files tab, the Transfer, Transfer All, Save, and Delete commands cannot be 
executed. 
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3 Double-click a study or select one, and then click OK. 

The main screen appears with the study log file images on it. The study log file mark appears on the 
main image and the study tab. 

Study log 
file mark

Functions on the study log file screen
The following functions are not available when a study log file on the main screen appears:
•	QA

•	Reject

•	Correction of patient information

•	Correction of image comments

•	Correction of study descriptions

•	Transfer of studies

•	Change of studies

•	Save of generated images

•	Capture of screen

For Stereo view and C/D ratio view, images can be viewed only.
Before adding or correcting a study description or performing C/D ratio measurement on a study 
in a study log file, first import the study (on page 86). 

4 Click Close to exit the screen. 
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Deleting Study Log Files
Study log files can be deleted in Explorer. 

1 Open the folder in which the study log files were saved. 

2 Select the folder of the study log file to be deleted, and press the Delete key. 

When a file or folder is deleted, it is saved temporarily in the recycle bin. To delete it completely 
from the computer's hard disk, open the recycle bin, select the file or folder, and then press the 
Delete key. 
To delete a file or folder completely without sending it to the recycle bin, press the Delete key while 
holding down the Shift key.
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Comparing Study Logs
You can compare the image of the current study with a study log, or compare images in different 
study logs on the Compare Studies screen. 
The Compare Studies screen appears only while a study appears on the main screen. 
The following describes how to compare a study log image during a study. 

1 Click  button (Compare Studies). 
The Compare Studies screen appears. 

2 Click the image to be compared from the thumbnail images on the left. 

The images in the current study can be compared on the left and right screens. In this example, 
button (Digital Redfree) has been clicked for the screen on the right. 

Study Logs

3 Click  button (Study Logs). 
The Study Logs screen appears. 
A search is performed using the Patient ID, and the search results appear on the Temporarily Saved 
tab. 
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To display a study that does not appear on the temporarily saved study log list
To display a study with a different patient ID from the temporarily saved study log, click Search, 
and set the appropriate search conditions on the Search screen (on page 72). 
To display study log files, click the Study Log Files tab, and select the study on the Study Log 
Files screen. If necessary, click Folder or Search, and either select the folder that appears, or set 
the conditions of the study that appears (on page 80). 

4 Select the study from the study list, and click OK. 

The selected study log image appears on the right side of the Compare Studies screen. Click the 
image to be compared from the thumbnail images on the right. 

Study 
Date/Time

Study log 
mark

Click the toolbar buttons to change the display format or application range of the operations. 

The main and thumbnail images appear together with the study information.

The main and thumbnail images appear.

The thumbnail images appear together with the study information.

The thumbnail images appear.

Images appear in the order that they were taken.

Images appear in the order of the retinal camera mode for the images.

When this option is enabled, an operation applied to the left or right image is applied to the 
other image. When the display is switched between RGB view and normal view, or Zoom In 
and Zoom Out button operations are performed for one of the images, the same operation is 
applied to the other image.
Application of an operation to both images is canceled when one of the following operations is 
performed:
•	Selection of another image

•	De-selection of an image

•	Opening if a different study
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To change the displayed items for the study information, click Edit List. The Edit List screen 
appears. Click OK to save the settings. 
•	To add an item, select the item in Hidden Items, and click the  button. 

•	To delete an item, select the item in Displayed Items, and click the  button. 

•	To change the display sequence, select the item, and then click the Up button or Down button 
to move the item. 

5 To continue comparing studies

•	To change the compared images, re-select the thumbnail images in the left and right screens. 

•	To display different study logs, click the Study Logs button and re-select from the study log list. 

6 Click Close.

The Compare Studies screen closes, and the main screen re-appears. 
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Importing Study Logs from External Storage Media
You can import study log files saved on external storage media and use them as temporarily saved 
study log data. 

The maximum number of studies that can be imported in a single operation is 100. When 
importing over 100 studies, divide them up into several groups first. 

1 Select the Study Log Files tab on the Study Logs screen. 

2 Select a study, and then click Import. 

To select two or more studies, click the images while holding down the Ctrl key. When calculation of 
the space required for importing the study data is completed, the Import screen appears. 

3 Click OK. 

The import is started. 

When a study having the same internal study instance UID is in temporary storage, the Check 
Skipped Study screen appears. 
Click OK. The import is resumed with the study displayed on screen not imported. From here on, 
the Check Skipped Study screen will appear in the case of similar studies. 
Clicking Skip All imports other studies from here on without importing studies having the same 
internal study instance UID. 
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Others

Adjusting the Brightness of the Observation Monitor
The brightness of the observation monitor of the retinal camera can be adjusted. 

1 Select Capture > Capture Settings... from the menu.

The Capture Settings screen appears. 

2 Drag the slider.

3 Click OK to close the screen. 

The brightness of the observation monitor changes.

Overlaying Study Information on Transferred Images
Patient information and study information can be overlaid on images transferred to the DICOM server 
and captured images that are exported in DICOM and JPEG format. For details on setting overlaid 
items, see "Setting Overlay." You can also set whether or not to overlay for each storage set to be 
transferred. See "Registering a DICOM Storage Server as the Storage Device," "Registering a Storage 
Device for Transferring Files in DICOM Format," and "Registering a Storage Device for Transferring 
Files in JPEG Format."

Patient ID
Patient name

Accession number

Study date

Right/left eye

Photography mode
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Saving Images as JPEG or TIFF Files
Selected image(s) can be saved as a JPEG or TIFF file. 

1 Click the thumbnail image to be output as a file. 

To select two or more images, click the images while holding down the Ctrl key. 

Setting the JPEG image quality
You can set the image compression and resizing options when saving images in JPEG format. 
Or, select File > JPEG Settings... from the menu. The JPEG Settings screen appears. Click OK 
to apply the settings. 

From 1 to 100
"100" represents 
the highest quality.

From 1 to 100

Select the width 
of the image after 
reduction.

2 Click File > Save As... from the menu. 

The Save As screen appears. Select the file type (Jpeg or Tiff) from the Save as type list box. 
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3 Specify the file name and folder where the image will be saved, and click Save. 

The default file name appears as shown below. Change it if required. 
“yyyyMMddhhmmssfff.xxx” (year/month/day/hour/minute/second/millisecond when the selected file 
appeared on the Save As screen, with "xxx" representing the extension, jpg or tif)

Folder where the image will be saved
 Windows 7/Windows Vista: Pictures
 Windows XP:  My Pictures

Changing the Password
You can change the password of the user who is currently logged in. 

1 Select File > Change Password... from the menu. 

The Change password screen appears. 

2 Input Current Password, New Password and New Password(confirm). 

3 Click OK. 

The password is changed and the screen closes. 

Acceptable characters for the password
For further details, see “Acceptable Characters” (on page 142).
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Checking the Number and Nature of the Transfer Errors

1 Click the  icon while the transfer error is occurring. The Transfer Error screen 
appears. 

Transfer status icon

The number of transfer errors and the nature of the errors appear on the Transfer Error screen. 
Check the nature of the errors, and take remedial action. For further details, see "5 Troubleshooting" (on 
page 127).

2 Click OK. 

The main screen re-appears and the transfer status icon disappears. 

Displaying the Version Information
Select Help > Version from the menu.
The Version Information screen appears. The software version appears on this screen. 
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This chapter describes the initial settings of the various functions in the Rics NM 2.

Setting Procedure

The setting procedure described here is for setting the items for System under Modality as an 
example. Use the same procedure for the other settings.

1 On the login screen, input the User ID and Password with which the privileges have 
been set to the Administrator, and click Settings. 

The Settings Menu screen appears.

2 Click the icon for which you want to perform settings in the Settings Menu screen. 

Click System. The System screen appears. 

3 Select the tab in which you want to perform settings.

4 Set the parameters, and click OK to save the settings. 

The System screen closes, and the Settings Menu screen re-appears.

5 Click Close.

The Settings Menu screen closes, and the login screen re-appears.

Login screen

Settings Menu screen

Setting screen

4 Settings
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System Settings
On the System screen, specify the modality details and set the timing for image transfer/saving, the 
specific character set to use in DICOM communication, and the separator between name elements.

System/System tab
Set the modality information for this retinal camera system. The item names in blue are set as 
essential input data. 

•	SOP Class (essential)
Select from the list box.

•	Modality (essential)
This is determined automatically in accordance with the SOP Class setting. (XC/OT/OP)

•	AE Title (essential)
The default value is “CANON_NM2”.

•	Station Name
Input the station name. Blank spaces only cannot be set. 

•	Location
Input the location. Blank spaces only cannot be set. 

•	 Institutional Department Name (essential)
Input the institutional department name. Blank spaces only cannot be set. 

•	 Institution Name (essential)
Input the institution name. Blank spaces only cannot be set. 

For details on essential item settings, see "Acceptable Characters" (on page 142). 
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System/Transfer Timing tab
On this tab, you can select the timing at which the study data is transferred to the storage device. 

　

•	When a study is completed
When a study is completed, study data is automatically transferred to the registered storage 
device.

•	Manual
When a study is completed, study data is not automatically transferred. The study data is saved as 
a temporarily saved study log. 
To transfer the data, display the Study Logs screen and select a storage device (on page 76). 
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System/Specific Character Set tab
On this tab, you can set the specific character set used for DICOM communication. 
Click , and select the desired character set from the list box. 

•	 For details on the tag value for the specific character set, see "Acceptable Characters" (on page 142). 

•	The setting for the specific character set needs to match the connected system (worklist/MPPS/
storage server). For details, check with the network administrator. 

•	The changed option is applied to transfer of new study data. The specific character set option 
for a set of study data is determined when the study is performed. So, the specific character set 
for study log data is not changed. 
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System/Other tab
On this tab, you can set the conversion rule for the separator between name elements in DICOM 
communication. 

•	Personal Name Conversion Rule
To convert the separator between name elements, select one of the options.
Selection of a conversion option changes the name display on the screen and output character 
string for DICOM communication.

A space into a caret: Converts a space into a caret (̂ ).
A comma into a caret: Converts a comma into a caret (̂ ).
A space and comma into a comma: Converts a space and comma into a comma.
Spaces into a space: Converts multiple spaces into a space.
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Device
On this screen, you can make the settings for the retinal camera and digital camera. 
Click Retinal Camera to display the Retinal Camera screen, or click EOS to display the EOS 
screen.

Retinal Camera/Settings tab
On this tab, you can set the port number of the serial port for communication with the retinal camera, 
and settings related to status control for the retinal camera. 

•	COM Port
Click  button or  button to select a number for the port where communication is made with the 
retinal camera (from 1 to 16).
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•	Connection Check...
Click this button to check connections on the port you have set. If connection with the retinal 
camera has been made properly, the Result of Retinal Camera Connection screen appears. 

•	Use of Focus Indicator
Selects whether or not to display the focus indicator.

•	Optical Head and Focus Position When Study is Completed
Selects whether or not to move the vertical position of the main unit and focus position to the initial 
position when study is completed.
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Retinal Camera/NM Settings tab
On this tab, you can set the options for the retinal camera in the non-mydriatic mode.

•	 Internal Fixation Lamp as Study Starts
Selects the lighting position of the internal fixation lamp when the study starts. To keep the lamp at 
the same position as the last time, select Do Not Move. 

•	Observation Magnification
Selects the magnification for observing the target eye on the observation monitor. 
The default magnification is 1.3x. 

•	Enlarge View for Focusing
Determines whether or not to zoom in the image of the observation monitor when the focus knob 
is turned. To zoom in the image, select Yes, and to not zoom in, select No.

•	Change Focus to Anterior After Every Exposure
Selects whether or not to return to the anterior eye observation after the retinal image has been 
taken.
This function is disabled in stereo photography even if Yes is selected. 

•	Use Guide to Capture for Stereo View
To display the stereo guide mark on the observation monitor when the Capture for Stereo View 
mode is selected, select Yes, and to not display, select No. 

•	Auto Exposure for Shoot

Selects whether or not to automatically adjust the flash intensity. The setting appears as  in the 
observation monitor of the retinal camera. When Yes is set, ON appears and when No is set, OFF 
appears. With Yes setting, every time the flash intensity button of the retinal camera is pressed the 
flash intensity is corrected by 0.3 stop.
This function is disabled in anterior eye photography even if Yes is selected. 

•	Auto Exposure for Observation
Selects whether or not to automatically adjust the observation light brightness. The setting 

appears as  in the observation monitor of the retinal camera. When Yes is set, ON appears and 
when No is set, OFF appears. With Yes setting, every time the observation light brightness button 
of the retinal camera is pressed the observation light brightness is corrected by 0.3 stop.
This function is disabled in anterior eye photography even if Yes is selected. 
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EOS/Settings tab
On this screen, you can select the model of the digital camera to connect to the Rics NM 2, and 
select the desired options. 

•	Model
Select the digital camera to be used from the list box. 
Click Connection Check.... If the connections have been made properly, the Information screen 
appears. 

When an Error screen appears, check the following:
•	 Is the retinal camera turned on?

•	 Is the digital camera turned on?

•	Are the retinal camera and PC connected by the specified cables?

•	Are the digital camera and retinal camera connected by the specified cables?

•	 ISO Speed
Select 1600 for standard photography. Select 3200 (LOW1) or 6400 (LOW2) for low flash intensity 
photography.

•	Capture Size
Select a size (L, M, or S).

•	Save Format
Select the image format for saving.
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Study Manager
In the Study Manager screen, set the storage folder of the study data (images and patient 
information), drive size warning, and the storage period. 

•	 Image Storage Folder
Specify any location on the local hard disk for storing the study data. Network drives and 
removable drives, such as DVD-R/RW, DVD-RAM, CD-R/RW, and USB flash drive, cannot be 
selected as the image storage folder. 

Do not change the path that was set at installation of the software. 

•	Display warning when available drive size is less than 
Select this item to display a warning screen when free space on the hard disk has fallen below the 
setting. Specify a value from 5 to 999 GB. 
When free space falls to 1 GB or less, the Error screen appears. Click Check Remaining 
Capacity to check the remaining free space on the hard disk and display the Information screen. 

•	Period: Study Logs are stored in Local Storage for
When the set number of days elapses after the study data transfer date, the study data is deleted. 
If a study targeted for deletion exists when you log out, the delete confirmation screen appears. 
Delete by following the displayed instructions. 
Specify a value from 0 to 999 days.
Example:  If this period is set to 5 days and you transfer study data on September 2, 2010, the 

study data is targeted for deletion at 00:00 on September 7, 2010.
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Study Input
On this screen, you can make settings for inputting patient information, such as the input method, 
essential input data and the input format. 
Keyboard, magnetic card/barcode reader, worklist, and list input can be selected as the study input 
method. You can use two or more items one by one to find and/or complete the study information. 
With worklist or study list, you can use the magnetic card or barcode for searches. With worklist, you 
can use MPPS. 

Study Input/Module Settings tab
On this tab, you can select the study input modules to be used.
In Module List, select the Status check boxes of the modules that you want to use. In the Study 
Input/MPPS Modules screen, the corresponding tabs appear arranged in the order that the 
modules are selected. In the Study Input screen, the tabs are arranged in the display order of the 
Module List. 
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Study Input/Manual Input tab
On this tab, you can set essential input data, input-disabled data, the method for entering birth date 
and the input format. 

•	Essential Data
Select the items which are to be set as the essential input data. Essential data is indicated in 
blue in the Study Input screen (on page 28). If Patient Name is selected as an essential item, the 
Setting Details screen will appear. Select Last Name and/or First Name to set as an essential 
item. 

•	 Input-Disabled Data
Select the items to disable inputting to.

•	Birth Date Input
Select the birth date input method from Fill in a Box with Separator or Fill in Separate Boxes. 
To specify May 23, 1986, for example, input “05/23/1986” or “23/05/1986” when Fill in a Box with 
Separator is selected; input “05,” “23,” and “1986” or “23,” “05,” and “1986” when Fill in Separate 
Boxes is selected. The date element order depends on the date format option set for the OS.

•	 Input Format
Select the items to set the format of the input items. The options (Length, Acceptable Character 
Set, Header string, and Filler Character) for the selected item are enabled. Then, set the 
parameters for these items as required. 

Length:    Specify the fixed length. Input a value from 1 to 64 for Patient ID, 
and from 1 to 16 for Accession No. If the value is not input for these 
items, the Patient ID field accepts up to 64 characters and the 
Accession No. accepts up to 16 characters. 

Acceptable Character Set: Select the available character type from the list box. 
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Header string:   Specify the character string added to the left side of input values. 
For example, if “ABC-” is specified and 16 is specified for Length, 
up to 12 characters can be input.

Filler Character:   If the input character string is shorter than the value specified in 
Length, the specified filler characters are used. For example, if 8 is 
specified for Length, 0 is specified for Filler Character, and “12345” 
is input, the filler characters are added to set “00012345”.

•	Automatic Accession No. Assignation
Select this checkbox to use the Automatic Accesion No. Assignation menu. This enables the Auto 
Counter Setting... button and enables the automatic numbering setting. Automatic numbering 
setting also can be set from the Study menu in the main screen. 

Procedure for Automatic Numbering Setting

1 Click the Auto Counter Setting... button. 

The Automatic Numbering Settings screen appears. 

2 Set the required options, and click OK. 

•	Assign Accession No. automatically
Select this checkbox to use the automatic numbering function. 

•	Counter ***** 
Enter the counter value for the accession No. to be assigned when the Study Input screen is 
opened. 
Enter within the range 0 to 999,999,999.
The ***** display value is the current counter value. 

To enable the automatic numbering function:
Select the Enable Automatic Accession No. Assignation checkbox, or select the Assign 
Accession No. automatically checkbox in the Automatic Numbering Settings screen. 

About the automatic numbering function and the Study Input screen
When the automatic numbering function is enabled, the Study Input screen is no longer opened, 
and patient information other than the accession No. cannot be input.
To input patient information, cancel the automatic numbering function by menu > Study > Set 
Auto Numbering... in the main screen. 
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Study Input/Mag Barcode Input tab
On this tab, you can set the essential items and the input method for the birth date during input from 
a magnetic card/barcode. 

•	Essential Data
Select the items which are to be set as the essential input data. Essential data is indicated in blue 
in the Study Input screen (on page 28). 

•	Birth Date Input
Select the birth date input method from Fill in a Box with Separator or Fill in Separate Boxes. 
To specify May 23, 1986, for example, input “05/23/1986” or “23/05/1986” when Fill in a Box with 
Separator is selected; input “05,” “23,” and “1986” or “23,” “05,” and “1986” when Fill in Separate 
Boxes is selected. The date element order depends on the date format option set for the OS.

Study Input/Worklist tab
On this tab, you can make settings for the display items, search conditions and worklist server.

For details on the setting information for the worklist server, check with the network administrator. 
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Setting the Display Items and Worklist Server
•	Worklist Server Settings

Input the AE title, host name and port number for the worklist server. Click Connection Check.... 
If the connections with the worklist server have been made properly, the following Information 
screen appears. 

When the Warning screen appears, check that the network and worklist server are operating 
properly. 

•	Number of Studies Acquired from Worklist Server
To change the maximum number of studies that can be acquired from the worklist server, select 
the desired number from the list box. 

•	Displayed Items
Select the item to be displayed in the Study Input screen from Hidden Items, and click the  
button. To move to Hidden Items, select the item in Displayed Items and click the  button. To 
change the display order, select the item, and click the Up button or Down button. 
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Setting the Worklist Search Conditions
Set the default values of the Worklist search screen (on page 32). 

1 Click Search Conditions. 

The Search Conditions screen appears. 

•	Search Conditions
Select Time, Range of Date or Range of Days and set the conditions. 

Time:   From 1 to 24.
Date:    Directly input the search start date and the search end date, or click  and 

select from Yesterday, Today and Tomorrow. Select the dates in the range 
extending from 1/1/1870 to 12/31/9999.

Range of Days: Select a number of days (999 or less) before and after today. 

•	Search Conditions: DICOM Tag Keyword
Select a tag from the list box and input a value on the right side. When a wild card (*) is used, a 
match is judged regardless of the tag value. The tags that can be selected are shown below. 

For details on essential item settings, see “Acceptable Characters” (on page 142). 

2 Click OK to save the settings. 
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Setting the Worklist Search Interval and Worklist Search Window
•	Display Worklist Search window

Select this item to first display the Search Conditions screen when the worklist is used for study 
input. This function is useful, for example, if there will be a large number of studies acquired from 
worklist. When the screen appears, input the search conditions and click OK. The worklists that 
were searched again appear. 

•	Worklist Search Interval
Set the time interval after which the worklist is automatically searched again during display of the 
Study Input screen. Specify this in minute units. Input a value from 1 to 60. If you do not want the 
search to be performed again, input 0. 

Study Input/MPPS tab
On this tab, you can make MPPS server settings and check the connections with the server. 

For details on the setting information for the MPPS server, check with the network administrator. 

1 Input the AE title, host name and port number for the MPPS server. 

2 Click Connection Check.... 

If the connections with the MPPS server have been made properly, the Information screen appears. 
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3 Click OK to save the settings. 

When a Warning screen appears, check the following:
•	 Is the network operating properly?

•	 Is the server working properly?

Study Input/List Input tab
On this tab, you can make the settings for study input using a study file (ccrhis.his) or study history file 
(ccrhis.hr) that has recorded patient information to perform study input. 

•	Displayed Items
The items selected for Displayed Items appear on the Study Input screen. Select the item in 
Hidden Items and click the  button to move to Displayed Items. To move to Hidden Items, 
select the item in Displayed Items and click the  button. To change the display order, select the 
item, and click the Up button or the Down button. 

•	Model No.
Input a number for identifying the retinal camera. Input a value from 1 to 99. 

•	Save the study file to
Click Browse... to select the folder where the study file (ccrhis.his) has been saved. The folder 
path should be 79 bytes or fewer. The user should have write permission to the folder. 
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•	Study Status
To update the study status that indicates start, cancel and end for the study file (ccrhis.his), select 
Change. 

•	Study Result
To add study cancel and end to the study history file (ccrhis.hr), select Add to the file, and to 
record only for the previous study result, select Update the study. If you do not want to record the 
study results, select Don’t save. 

When using the study file (ccrhis.his) and study history file (ccrhis.hr), if you have any questions or 
want advice regarding the file specifications or operation methods, contact a Canon representative 
or distributor. 

Storage
The following options are available to transfer study data to a storage device.
1. DICOM storage server
2. Export (DICOM file)
3. Export (JPEG file)

Up to ten storage devices can be registered, and up to two storage devices can be set as 
simultaneous destinations in a single transfer. 

For details on the acceptable characters for the Storage Settings screen, see “Acceptable 
Characters” (on page 142).

Registering a DICOM Storage Server as the Storage Device

1 Click Create... on the Storage screen. 

The Create a New Storage screen appears. 
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2 Select Storage Server under Storage Type. 

3 To anonymize the patient information, select Anonymize Patient Info..

For details on essential item settings, see "Anonymizing the Patient Information" (on page 114).

4 Input Storage Name, Server AE Title, Host Name, Port No., SOP Class, and 
Modality.

For details on the storage server settings, ask your network administrator. 

5 Click Connection Check... to check the connection with the server. 

The Information screen appears if the connection has been made properly. Click OK to close the 
screen.
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6 Set Image Compression. Select one of the methods. 

When Lossy JPEG has been selected, input a number from 1 to 100 for JPEG Quality. "100" 
represents the best image quality. 

7 Select Overlay Annotation to perform this.

8 Select Set as Default Storage to set as the default storage. 

Up to two default storage devices can be set. 

9 Click OK to save the settings. 

Registering a Storage Device for Transferring Files in DICOM Format

1 Click Create... on the Storage screen. 

The Create a New Storage screen appears. 

2 Select Export (DICOM) under Storage Type. 

3 To anonymize the patient information, select Anonymize Patient Info..

For details on essential item settings, see “Anonymizing the Patient Information” (on page 114).
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4 Input Storage Name, Storage Folder, SOP Class, and Modality. 

Click Browse... to display the Browse For Folder screen, and select the destination for Storage 
Folder. 

To specify a CD or DVD drive as the export destination, a software (driver) that records using the 
packet write system is required for some operating systems. Use CD or DVD media that have been 
formatted using the packet write system. 

5 Set Image Compression. Select one of the methods. 

When Lossy JPEG has been selected, input a number from 1 to 100 for JPEG Quality. "100" 
represents the best image quality. 
When No Compression is selected, Transfer Syntax is enabled. Select one of the items. 

6 Select Overlay Annotation to perform this.

7 Select Set as Default Storage to set as the default storage. 

Up to two default storage devices can be set. 

8 Click OK to save the settings. 

Registering a Storage Device for Transferring Files in JPEG Format

1 Click Create... on the Storage screen. 

The Create a New Storage screen appears. 
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2 Select Export (JPEG) under Storage Type. 

3 To anonymize the patient information, select Anonymize Patient Info..

For details on essential item settings, see “Anonymizing the Patient Information” (on page 114).

4 Input Storage Name and Storage Folder. 

Click Browse... to display the Browse For Folder screen, and select the destination for Storage 
Folder. 

To specify a CD or DVD drive as the export destination, a software (driver) that records using the 
packet write system is required for some operating systems. Use CD or DVD media that have been 
formatted using the packet write system. 

5 Set Image Compression. Select one of the methods. 

Input a number from 1 to 100 for JPEG Quality. "100" represents the best image quality. 

6 Select Overlay Annotation to perform this.

7 Select Set as Default Storage to set as the default storage. 

Up to two default storage devices can be set. 

8 Click OK to save the settings. 
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Anonymizing the Patient Information

1 Select Anonymize Patient Info. on the Create a New Storage screen or Edit Storage 
Settings screen. 

2 Click Anonymize Settings....

The Anonymization Settings screen appears. 

•	Select the items that you want to anonymize. 

•	Select the Anonymization Type from the list box (Blank or Replace). 

•	When Replace is selected for Anonymization Type, input a text string that replaces the original 
value. 

3 Click OK to save the settings. 
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Setting the Export Setting Options

1 Click Details... on the Create a New Storage screen. 

The Export Settings screen appears.

•	Create Folder
Select this option to create a folder for saving the image files each time the study data is exported. 
Select Storage Date or Study Date for the folder name format. 

•	Filename
Select the name format for the image file. 
When Saving Date Time is selected, "yyyyMMddhhmmssfff.ext"
(Year, month, date, hour, minute, second, and millisecond when the file was stored)
When Study Date Time + Study ID + ... is selected: "yyyyMMddhhmmssEEEESSIIIttt.ext"
(EEEE: Study ID, SS: Series number, III, Instance number, ttt: Study transfer count)
(ext: dcm for Export (DICOM), jpg for Export (JPEG))

•	Add Patient Info. to the filename
Select this option to add the patient information to the file name. Then, select Patient ID, Accession 
No. or Patient Name. 
File format: “Patient information” + “_” + “file name”.ext
(ext: dcm for Export (DICOM), jpg for Export (JPEG))

•	Resize (with fixed aspect ratio) 
This option is disabled when Export (DICOM) is selected.
Select this option to change the image size.
Ratio: Specify the percentage compared to the original image.
Size (Width): Select a value from the list box.

2 Click OK to save the settings. 
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Setting the Storage Server
You can specify the time-out period for transferring to the registered storage server. 
Click Storage Server Settings... on the Storage screen. The Storage Server Settings screen 
appears. 
Set the items on the screen, and click OK. Input a number from 1 to 600 for each item. 

Setting Overlay
You can specify the patient information and study information to display on images to be transferred. 
Click Overlay Settings... on the Storage screen. The Overlay Settings screen appears. 
Select the patient information, image information, and study information to be displayed, and click 
OK. 

Changing the Registered Information
Select a storage device on the Storage screen and click Edit. The Edit Storage Settings screen 
appears. 
Change the registered information by referring to the corresponding section shown below. 

Storage Type Reference section

Storage Server Registering a DICOM Storage Server as the Storage Device (on page 109)

Export (DICOM)
Registering a Storage Device for Transferring Files in DICOM Format (on 
page 111)

Export (JPEG)
Registering a Storage Device for Transferring Files in JPEG Format (on 
page 112)

Deleting Storage Devices
Select a storage device on the Storage screen, and then click Delete.
The Warning screen and the "Storage will be deleted from the list." message appear. Click OK to 
delete the storage device. 
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DICOM Tag
On this screen, you can select the study information to be saved in the DICOM tag, and whether or 
not to update the instance UID on re-transfer. 

DICOM Tag/Study tab

•	Create Series for Right/Left Eye
If this option is selected, a new series is created when the left and right eyes have been changed. 

•	Set “Scheduled Performing Physician’s Name” to “Performing Physician’s Name”
If this option is selected, the scheduled performing physician’s name of the acquired worklist is 
saved as the performing physician’s name of the DICOM tag information on the images.
If this option is not selected, the login user name is saved as the performing physician’s name.

•	Window Center/Window Width
Select this option to save the window center and window width in the DICOM tag. 
However, note that when “Ophthalmic Photography 8 Bit Image Storage” is selected for SOP 
Class for the storage device, the values will not be saved even if this option is selected.

•	Save as “Image Comments”
Select this option to save retinal camera image information in the DICOM tag. 
If this option is not selected, only content that is input in the Image Property will be saved. 
For details on the retinal camera image information, see "DICOM Tag/Study tab/Image Comment 
Settings" (on page 118).
Click Details to display the Image Comment Settings screen. 
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DICOM Tag/Study tab/Image Comment Settings

On this screen, you can select the information to be saved in the DICOM image comment tag and 
display order. 
What has been set on this screen will not appear as the Image Comments of the Image Property 
screen. 
To display the Image Comment Settings screen, click Details... on the DICOM Tag/Study tab 
screen. 

•	Format (essential)
Enter an alphanumeric character to be used as the Tag Mark and Separator. 
For instance, if “:” is used for the Tag Mark and “/” as the Separator, they will be saved as follows. 
Example: Brightness:0/Contrast:0/Gamma:1.00

•	 Items
To add Enabled Items, select the item in Disabled Items, and click the  button. 
To delete Enabled Items, select the item and click the  button.
To change the sequence in which the items are saved, select the item, and then click the Up 
button or Down button.
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DICOM Tag/Study Logs tab
On this screen, you can select the settings for updating the DICOM information when re-transferring 
the study logs information. 
However, these settings do not apply to studies that have not yet been transferred.

•	Update “Study Instance UID” on re-transfer
Select this item to issue a new study instance when re-transferring the study as follows.
A new instance UID is as follows. 
Model UID. study ID. transfer time (yyyyMMddhhmmss)

•	Update “Series Instance UID” on re-transfer
Select this item to issue a new series instance when re-transferring the study as follows.
A new series instance UID is as follows. 
Model UID. study ID. transfer time (yyyyMMddhhmmss). series number

•	Update “SOP Instance UID” on re-transfer
Select this item to issue a new SOP instance when re-transferring the study as follows.
A new SOP instance UID is as follows. 
Model UID. study ID. transfer time (yyyyMMddhhmmss). series number. instance number (image 
number). suffix for the storage device

Whichever item is selected, only the transfer time is updated. 
Furthermore, it is the information of the images to be re-transferred that is updated and not the 
information of the images saved. 
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User Accounts

On this screen, you can create, delete and edit a login user, Also, you can change the login password. 
The user is authenticated with a user ID and password. The user name is saved as the DICOM tag 
“Operator’s Name”. 

Registering Users
In this system, up to 20 login users can be registered. 

1 Click Create... on the User Accounts screen. 

The Create a new account screen appears. 

2 Input the user ID, password, and input the password again for confirmation. 

Input the User Name options if required. The item names in blue are essential input data. 

For details on the acceptable characters for each item, see “Acceptable Characters” (on page 142). 



4 Settings

121

3 Set Privilege. 

Select the Administrator privilege for users who will operate the Settings Menu. Click OK to save the 
user registration information. 

Changing the User Information
Select a user on the User Accounts screen, and click Change....
The Change an account screen appears. Change User Name and/or Privilege, and click OK. 

Deleting the User
Select a user on the User Accounts screen, and click Delete.
The Warning screen appears. Delete by following the displayed instructions.

Resetting the User Password
Select a user on the User Accounts screen and click Reset password.... The Reset password 
screen appears. Input the password at both New Password and New Password (confirm), and 
click OK. 
The new user password is saved and the screen closes. 
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Screen

On this screen, you can select the information which appears on the main screen. Check the settings 
for each tab and change if necessary. 

Screen/Main Image Info. tab
On this tab, you can select the items which appear on the main image area. 
Select the desired items. 

Screen/Thumbnail Image Info. tab
On this tab, you can select the items which appear on the thumbnail image area.
Select the desired items. 
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Screen/Study Info. tab
On this tab, you can select the items which appear in the study information area. 

To add Displayed Items, select the item in Hidden Items, and click the  button. To delete 
Displayed Items, select the item and click the  button. 

To change the sequence in which the items appear, select the items in Displayed Items, and then 
click the Up button or Down button.

Screen/Thumbnail Order tab
On this tab, you can select the thumbnail display sequence. 

•	R/L
R->L displays the eye in order right eye and then left eye. 
L->R displays the eye in order left eye and then right eye. 

•	Content Time
When Sort Ascending is selected, the thumbnail images appear from left to right starting with the 
oldest. 
When Sort Descending is selected, the thumbnail images appear from left to right starting with 
the most recent. 
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Screen/Loupe tab
On this tab, you can select the display size and magnification for the Loupe tool (L, M or S). 

Screen/C/D Ratio tab
On this tab, you can select the magnification ratio when the image on the C/D Ratio screen is clicked 
(L, M or S). 
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Screen/Stereo View tab
On this tab, you can select the magnification ratio when the image on the Stereo View screen is 
clicked (L, M or S).
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Print

On this screen, you can set the function of the Print button on the main screen. Select Print with 
Easy-PhotoPrint EX to assign Easy-PhotoPrint EX. If this option is not selected, Simple Printing is 
assigned. 

Study Log

On this screen, you can set the number of days for display on the Study Log. 
To display a study list for the previous week, for example, input "7". 

Magnetic Card/Bar Code

On this screen, you can set the serial/USB communication settings for the magnetic card/barcode 
reader and the settings for the magnetic card/barcode data. 
The settings vary depending on the devices that you are using. For details, please contact a Canon 
representative or distributor.
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Appearance of the Message Screen
A message screen appears when trouble has occurred or when there is information for the user. In 
this case, take the corrective action shown in the table below. If the message screen does not close 
or if an error or warning message not shown in the list appears, contact a Canon representative or 
distributor. 

Error message

Warning message
Check the message details. If you do not understand the corrective action in the message, 
see the Error list or Warning list based on the message type, module id, and message id. 

Message screen (Error)

Information message
This message indicates that the operation was performed properly. Click OK to close the 
message screen.

5 Troubleshooting
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Error List
module id message id Message Remedy

00005 5 Specified User ID already exists.
The User ID which has been input is already registered. 
Change the User ID.

00011

1 Fail to open Omron Device. •	 Check that the OMRON device is connected 
correctly.

•	 Check that the device number is assigned correctly.

•	 Check that the driver is installed correctly.

2 Fail to close Omron Device.

10002 101 Failed to connect to specified EOS. Check the connection with the EOS digital camera.

10003 2 Incorrect Entry of Date for Search Conditions
Open the Search screen (on page 72) from the Study 
Logs screen, and then input the correct date.

10004

29
Insufficient Free Space in Storage Folder
No image can be captured.
[** GB]

No images can be taken since the free space on the 
drive containing the storage folder is less than 2 GB.
Increase the amount of free space on the drive.

3701
Service cannot start.
Service name: MSDTC
Display name: Distributed Transaction Coordinator

Set the startup type of the service to a setting other 
than “Disabled.”

4100 Error on Saving to External Storage
Check that the specified saving destination can surely 
save the study(ies).

4103
Failed to read the external study.
[File name]
The file has been corrupted.

Try to display the study log file again. If this fails, the 
data may be corrupted. If the data is retained in the 
Temporarily Saved, try saving again.

4106
A folder or file without access rights exists under 
the specified folder.

Select a folder again in the Browse For Folder screen. 
Select the study logs file folder or a folder at the 
nearest possible level.

4107
The path of the specified folder exceeds the 
maximum length.

Move the folder of the study logs file to a location 
where the folder path is 150 characters or less. Click 
Folder, and specify the new folder location in the 
Browse For Folder screen.

10005

1001 Failed to open a port.

•	 See “Retinal Camera/Settings tab” (on page 96), and 
check the port number setting.

•	 Disconnect the retinal camera communication cable, 
then connect the cable again.

1007
Power for the retinal camera is turned off or the 
cable is improperly connected.

Check that the computer and retinal camera are 
connected correctly.

1501
Error occurred during communications with the 
retinal camera.
Failed to resend the command frame.

Turn the retinal camera’s power off and back on.

1502
Error occurred during communications with the 
retinal camera.
Failed to resend the reply frame.

1503
Error occurred during communications with the 
retinal camera.
Time-out for No Response

1504
Error occurred during communications with the 
retinal camera.
Time-out for Incomplete Transmission

1603
Cameras are not attached to the main mount and 
sub-mount of the retinal camera.

Check that the digital camera is connected correctly.

1701
Connected retinal camera model is different from 
the model setting in this software.

Check the model of the retinal camera.

10007 4 JPEG File Saving Error
Check how much free space is left on the hard disk 
where the data is to be saved.
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10010

1
Failed to log in.
Confirm User ID/Password.

Input the User ID and Password registered in the user 
account (on page 120), and log in.

2 It cannot be set without administrator’s privileges.
Log in using the User ID for which the Privilege has 
been set to the Administrator (on page 120).

10011

2 This application is already running. Use the software application which is running.

101 Set the screen resolution to 1024 × 768 or more.
Set the Windows screen resolution to 1024 x 768 or 
more.

102 Set the screen color to 24 bits or more. Set the Windows color quality to 24 bit or more.

110
Operation can be executed by a Windows user 
with Administrator privileges.

Log into Windows using the name of the user 
belonging to the Administrators group.

114
Essential data has not been set up.
Set up essential data.

Input the required items.

10012

27

Free space in the drive is not sufficient to capture 
images.
Make up space in the drive by deleting studies in 
Study Logs List.
[Drive:XX freesize: XXGByte(XXbyte)]
[Drive: XX] Delete study log images (on page 71) to increase the 

amount of available space in the image storage drive.

29

Image cannot be captured due to insufficient 
space to store captured image.
Make up space in the drive by deleting studies in 
Study Logs List.
[Drive:XX freesize: XXGByte(XXbyte)]

30
Number of captured images exceeds the maximum 
for the study.
No more image can be captured for the study.

End the study, and start a new study.

10019

7 MPPS Communication Error
Check that the MPPS server is operating properly.
Check the MPPS tab (on page 107) settings.

11
Study cannot be executed since a study having the 
same Study Instance UID is running.

Check the study information which was transmitted 
from the server.

10024
311 No main image is selected. Select an image.

10308 No image is selected. Select the target image.

10031 3
Neither Manual Input nor Mag Barcode Input is 
selected.
Either or both of them must be selected.

Select the Manual Input tab (on page 102) or the Mag 
Barcode Input tab (on page 104) on the Module Settings 
tab.

10040

104 No Storage Folder Check the name of the storage folder.

105 Failed to create a folder. Check the access permissions for the storage folder.

106 The same file name exists in the storage folder.
Either change the name of the storage file, or delete 
the file with the same name.

10041 105 Failed to create an image.

If a message that indicates shortage of memory 
appears with this message and the main image won’t 
appear, select the thumbnail again.
If a message that indicates shortage of memory 
appears with this message at transfer, try the transfer 
again.
If the message appears in situations other than those 
shown above, contact a Canon representative or 
distributor.

10045

5
Failed to search worklist.
It may be caused by communication failure with 
the worklist server.

Check that the worklist server is operating properly.

25
Failed to initialize the magnetic card/bar code 
device.

Check the magnetic card/barcode reader connection.
The magnetic card/barcode reader settings need to be 
made.
Please contact a Canon representative or distributor.10048 41

Failed to initialize the magnetic card/bar code 
device.
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10049

11 Failed to register Patient Info. in the database.
The study progress status could not be saved to the 
study file. Check if the study file (ccrhis.his) is set to 
read-only.

49
Failed to initialize the magnetic card/bar code 
device.

Check the magnetic card/barcode reader connection.
The magnetic card/barcode reader settings need to be 
made.
Please contact a Canon representative or distributor.

50
The studies were not read. Number of studies 
exceeded the maximum to read.

Please reduce the number of studies in the study file 
(ccrhis.his) to the number of displayable studies.

10052

100 No printer is installed.
Install the printer from the Printers and Faxes screen 
in the Control Panel.

200 No main image is selected. Select the printing image.

201
Image Read Error
Only print info. is output since image reading has 
failed.

The printing information and the text “NO IMAGE” are 
printed for images where a reading error has occurred.

300
Print Error
Printing is cancelled. Check the printer server and network cable 

connections.
301

Print Error
Printing is cancelled.

10053 8

Failed to communicate with the magnetic card/bar 
code reader.
Check the cable.
Check the settings.

Check the magnetic card/barcode reader connection.
The magnetic card/barcode reader settings need to be 
made.
Please contact a Canon representative or distributor.

10056

204 No Storage Folder
See “Storage” (on page 109), click Edit in the storage 
setting screen, and check the storage folder.

205 The same file name exists in the storage folder.
Either delete the file with the same file name at the 
storage folder, or change the storage.

206 Failed to save JPEG File. See “Software” (on page 10), and set the proper access 
privileges for the storage folder.207 Failed to create a folder.

10063 1 JPEG File Saving Error

Check the following items at the save destination:

•	 Does a file with the same file name exist?

•	 Does the login user have access rights to save files?

•	 Is there enough space to save the file on the drive?

10067

6 Specified folder does not exist or is not accessible. Specify the folder again.

7 No right to read contents in the folder.
See “Software” (on page 10), and set the proper access 
privileges for the storage folder.

9 Not Recognized as a folder. Specify the folder again.

10 No right to write contents in the folder.
See “Software” (on page 10), and set the proper access 
privileges for the storage folder.
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10001

1002

Invalid image was captured.
Failed to acquire Retinal Camera Info. within the 
specified time.
No Validity for Current Study

•	 Do not press the shutter button of the digital 
camera.

•	 Check that the computer and digital camera are 
connected correctly.

•	 Turn the equipment’s power off and back on, and 
take a test image.

1009
Photography frequency exceeded the limit.
Please wait.

Images cannot be saved since images were taken 
continuously over a short period of time. Wait for a few 
moments, and then take the images.

10002

1000
Failed to connect to EOS.
Check the cable.
Check the power supply.

Check that the computer and digital camera are 
connected correctly.
Check that the digital camera is turned on.

1004
Auto power off option is enabled on EOS.
Select Off for Auto power off.

Set the Auto power off to Off on the digital camera.

1005 Communications with EOS was disconnected.
Check that the computer and digital camera are 
connected correctly.
Check that the digital camera is turned on.

1006
EOS battery is almost empty.
Supply power with the DC coupler.

Supply the power of the digital camera using the DC 
coupler.

1011
Some data is recorded in the memory card in EOS.
The performance may drop when a data-
containing memory card is loaded in EOS.

Remove the CF card from the digital camera body.

10003

1 Selected study will be deleted.
To delete a study, click OK; to cancel the deletion, click 
Cancel.

3 No Storage Selected Select the storage, and then transfer the image.

4
Invalid Patient ID
Includes the character ‘\’.

Delete the backslash (\).

7
Invalid Patient Name
Includes the character ‘\’ or ‘=’.

Delete the backslash (\) or equal sign (=).

8
Invalid Patient Name
Enter in alphanumeric.

Delete the characters which are not single-byte 
alphanumerics or symbols.

9

Invalid Study Description
Includes ‘\’, control character, or character 
unsupported by the specified Specific Character 
Set.

Delete the backslash (\) or control character and input 
in the specific character set.

203
The study being transferred is selected. Failed to 
transfer. No operations can be performed for studies being 

transferred so wait until the transfer is completed.
204

The study being transferred is selected. Failed to 
delete the study.

205
Number of the selected studies exceeds the 
maximum for import ([100]).

Limit the number of studies to import to 99 and try 
importing again.

206
Failed to import the study. A study is being 
transferred.

Try importing again after the transfer ends.

207
Failed to save the study. The selected study is 
being transferred.

Try saving again after the transfer ends.

11004

Study Logs screen cannot display all logs. 
Number of study logs to be displayed exceeds the 
maximum.
Change the search conditions.

Change the search conditions (on page 72).
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10004

25
Required fields must be entered.
[item]

Input the required items. The titles of the required items 
are indicated in blue.

26
The path for storage folder exceeds the maximum 
length.
[Max. *** bytes]

Select a folder where the path for the Image Storage 
Folder (on page 100) is fewer than 150 bytes.

27 Storage folder does not exist.
Check that the storage folder (on page 100) which has 
been set actually exists.

28 Drive specified for storage folder is not a fixed disk. Set the storage folder (on page 100) on the fixed disk.

30
Insufficient Free Space in Storage Folder
[** GB]

Increase the amount of free space on the fixed disk on 
which the storage folder has been set (on page 100).

41
Invalid [item]
Enter in alphanumeric.

Input tags and delimiter characters in the Image 
Comment Settings screen (on page 118) using single-
byte alphanumerics and symbols. 

4105

Failed to read the external study.
[File name]
This product cannot read studies saved with newer 
version than the version of this product.

Upgrade the version of the Retinal imaging control 
software NM 2 to the same version as that you used to 
save the file, or to a newer version.

10005

103
Over Discharge
Do not operate the retinal camera for a while.

Wait for a few moments, and then take the images.

108 Communication Protocol Error
•	 Turn the retinal camera’s power off and back on.

•	 Turn the computer’s power off and back on.

109
Photography frequency exceeded the limit.
Please wait.

Images cannot be saved since images were taken 
continuously over a short period of time. Wait for a few 
moments, and then take the images.

202 X-contact Error in EOS Camera Mode
Turn the equipment’s power off and back on, and take 
a test image.

205 Flash Not Fired

206 X-contact Error in EOS Camera Mode

207 Invalid Diopter Lens Potision.
Check that the position of the diopter compensation 
knob is correct.

10006

1000

Default QA parameters for [Photography] mode will 
be changed.
If Image Optimization is enabled, the default QA 
parameters will not be used.

To return the current settings to the default values, 
click OK on the QA (Quality Assurance) screen (on 
page 46).

1001 Selected QA parameter set will be deleted.
To delete the current QA parameter set, click OK on 
the QA (Quality Assurance) screen (on page 46).

1002
Current QA parameter values will be applied to all 
the selected images.

To apply the current settings to all the selected images, 
click OK on the QA (Quality Assurance) screen (on 
page 46).

1003 Selected QA parameter set will be updated.
To overwrite the QA parameter set with the current 
settings, click OK on the QA (Quality Assurance) 
screen (on page 46).

10009 1000

Invalid Image Comments.
Includes control character except line feed or 
character unsupported by the specified Specific 
Character Set.

Delete any control characters. Input in the designated 
specific character set.

10010 8

Invalid User Name
Includes character unsupported by the specified 
Specific Character Set.
Change the user name for User Accounts.

Input the user name using the specific character set.
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10011

104 Enter User ID/Password. When logging in, input the user ID and password.

105
Invalid User ID or Password.
Enter in alphanumeric.

Input the user ID/password in single-byte alphanumeric 
characters.

109
Application will be closed.
Press Cancel button and log in to the application 
to view the details of the transfer error.

To check the details of the transfer error, click Cancel, 
and then log in.

10012 28

Image can be captured but the storage space for 
captured images runs short.
Make up space in the drive by deleting studies in 
Study Logs List.

Delete studies in the study log screen to increase the 
amount of available space in the drive.

10013
50

Images stored for more than the specified periods 
will be deleted.

To delete the images, click OK.

85 Application cannot be terminated during transfer. Close all studies after transfer, then exit the software.

10019

10
A study with same Accession No. or Patient ID is 
now in progress.
Do you want to create a new study ?

To start as a new study, click YES.

12
A study with same Accession No. or Patient ID is 
now in progress.
Do you want to update ?

To update the study information, click YES.

10020

1000
No Storage Selected
Image(s) will not be transferred.

Select the storage, and then transfer the image.

1001
Transfer for this study is in progress.
You can’t transfer it before the transfer is 
completed.

Wait until the transfer is completed before performing 
the transfer.

10023

1
Invalid Birth Date
The entered value could not be converted to a 
birth date.

Input the birth date appropriately.

5
Patient Info. set as any of essential data items are 
not entered.

Input the required item that appears.

6
The length of either of 5 Patient Name fields is too 
long.
Shorten the length to 60 characters or less.

Shorten the length to 60 characters or less.

12
The following items are invalid.
[item]

Re-input the data based on the information that 
appears in Details.

14
Invalid Study Description
Includes line feed.

Delete the line feed code.

15
Too Long Patient Name.
Shorten the total length of the 5 items to 60 
characters or less.

Input the Patient name in 60 characters or less for all 
five items total.

16 Length of Accession No. exceeds the limit. Input within the limited length.

17

Invalid Accession No.
Includes character other than the specified 
Acceptable Character Set or character 
unsupported by the specified Specific Character 
Set.

Input using the designated input character type or 
specific character set.

18 Length of Patient ID exceeds the limit. Input within the limited length.
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10023

19

Invalid Patient ID
Includes character other than the specified 
Acceptable Character Set or character 
unsupported by the specified Specific Character 
Set. Input using the designated input character type or 

specific character set.

21

Invalid Study Description
Includes character other than the specified 
Acceptable Character Set or character 
unsupported by the specified Specific Character 
Set.

22

Invalid Accession No.
Includes ‘\’, control character, or character 
unsupported by the specified Specific Character 
Set. Delete the backslash (\) and any control characters.

Input in the designated specific character set.

23

Invalid Patient ID
Includes ‘\’, control character, or character 
unsupported by the specified Specific Character 
Set.

24

Invalid Study Description
Includes ‘\’, line feed, control character, or 
character unsupported by the specified Specific 
Character Set.

Delete the backslash (\), line feed code, and any 
control characters. Input in the designated specific 
character set.

29

Invalid Last Name
Includes ‘\’, ‘̂ ’, control character, multi-byte 
character or character unsupported by the 
specified Specific Character Set.

31

Invalid First Name
Includes ‘\’, ‘̂ ’, control character, multi-byte 
character or character unsupported by the 
specified Specific Character Set.

33

Invalid Middle Name
Includes ‘\’, ‘̂ ’, control character, multi-byte 
character or character unsupported by the 
specified Specific Character Set.

35

Invalid Prefix
Includes ‘\’, ‘̂ ’, control character, multi-byte 
character or character unsupported by the 
specified Specific Character Set.

37

Invalid Suffix
Includes ‘\’, ‘̂ ’, control character, multi-byte 
character or character unsupported by the 
specified Specific Character Set.

39
Invalid Birth Date
The valid date ranges from a date in the year 1870 
to today.

Input a valid birth date value.

40
Invalid Birth Date
The entered value could not be converted to a 
birth date.
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10023

55

Invalid Last Name
Includes character other than the specified 
Acceptable Character Set or character 
unsupported by the specified Specific Character 
Set.

Input in the designated Acceptable Character Set of 
the specific character set.

56

Invalid First Name
Includes character other than the specified 
Acceptable Character Set or character 
unsupported by the specified Specific Character 
Set.

57

Invalid Middle Name
Includes character other than the specified 
Acceptable Character Set or character 
unsupported by the specified Specific Character 
Set.

58

Invalid Prefix
Includes character other than the specified 
Acceptable Character Set or character 
unsupported by the specified Specific Character 
Set.

59

Invalid Suffix
Includes character other than the specified 
Acceptable Character Set or character 
unsupported by the specified Specific Character 
Set.

60 All the items are disabled to input. Check the input-prohibited items.

61
There is no header string set up in Input Format.
Do you want to start or end study?

Check the header character string that was set in Input 
Format (on page 102).

62

Invalid Ethnic Group
Includes ‘\’, control character, or character 
unsupported by the specified Specific Character 
Set.

Delete the backslash (\). Input in the designated 
specific character set.

64 Length of Ethnic Group value exceeds 16 bytes. Input the value within 16 bytes.

65
The length of Study Description field is too long.
Shorten the length to 64 characters or less.

Input the value as instructed by the message.

10024

4

Invalid Study Description
Includes ‘\’, control character, or character 
unsupported by the specified Specific Character 
Set.

Delete the backslash (\). Input in the designated 
specific character set.

321
The selected images include a stereo pair. No 
deletion will be performed.

Cancel pairing, and try deleting again.

11004

Invalid Study Description
Includes ‘\’, control character, or character 
unsupported by the specified Specific Character 
Set.

Delete the backslash (\). Input in the designated 
specific character set.

11005 One or more studies are in progress. End the study.

12001 Number of selected images is not two. Select two images.

12003
The Stereo View screen will display images that 
the stereo pair information of each image does not 
match each other.

To re-select images having the same stereo pair 
information, click Cancel.

15003 Right and Left Eyes
To display images in stereo view, select two images of 
right or left eye.

15005 Different Zoom Rates
To display images in stereo view, select images of the 
same zoom rate.
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10024

15006 Different Image Sizes
To display images in stereo view, select images of the 
same image size.

15008 Different Image Formats
To display images in stereo view, select images of the 
same format.

15013
The picture style for one image is different from the 
style for the other.

To display images in stereo view, select images of the 
same picture style.

15015 Different Derived Modes.
To display images in stereo view, select images that 
have been processed in the same way.

15016 Anterior and retinal images are selected.
To display images in stereo view, select two anterior 
eye images or two retinal images.

16002 Capture for stereo view cannot be finished.
Click OK and then capture images for stereo view 
again.

10026

102
Enter essential data.
[item]

Input the required items.

103
The following items are invalid.
Enter in alphanumeric except ‘\’.
[item]

Delete the backslash (\).

105
The following items are invalid.
Includes the character ‘\’ or character unsupported 
by the specified Specific Character Set.

Delete the backslash (\). Input in the designated 
specific character set.

10027

1001 No default is registered.
When a storage has been registered, check “Set as 
Default Storage” for one of the storages.

1101
Length for a storage path exceeds the maximum.
[Max. ***]

Select a folder where the number of characters for the 
Image Storage Folder (on page 101) is fewer than 150 
characters.

1102
Enter essential data.
[item]

Input the required items.

1103
Invalid [item]
Enter in alphanumeric.

Use alphanumerics for the input.

1104
Invalid [item]
Enter in numeric.

Use numerics for the input.

1105 Duplicated Storage Name Change the Storage Name.

1106
Invalid [item]
Enter a value between [value 1] and [value 2].

Input a value in the range.

1107
Invalid [item]
Entered value could not be checked.

Use numerics for the input.

1110
Association with Storage Server was rejected.
Check the settings and status of Storage Server.

•	 Check that the storage server is operating properly.

•	 Check the settings on the Create a New Storage 
screen (on page 109).

1111
Invalid [item]
Enter in alphanumeric except ‘\’.

Delete the backslash (\).

1114 Storage folder does not exist. Specify the folder again.

1401 Storage will be deleted from the list. To delete the storage, click OK.

1601
The length of Patient Name fields is too long.
Shorten the total length of the 5 fields to 60 
characters or less.

Shorten the total length of Patient Name fields to 60 
characters or less.

1603 Invalid [item]
Includes the character ‘\’ or character unsupported 
by the specified Specific Character Set.

Delete the backslash (\). Input in the designated 
specific character set.1604

1605
Invalid [item]
Enter a 3-digit numeric (nnn) and a capital Y, M, W, 
or D - in the format nnnY, nnnM, nnnW, or nnnD.

Input as instructed in the message.
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10027

1606

Invalid [item]
Includes character other than 0 to 9, ‘+’, ‘-’, ‘.’, ‘E’, 
and ‘e’ or it cannot be converted into a numeric 
value.

Input using numerics and/or characters shown in the 
message.

1608

Invalid [item]
Includes the character ‘\’, ‘=’, ‘̂ ’, or character 
unsupported by the specified Specific Character 
Set.

Correct the entry of Replace field for the item.

2001
Number of selected storages exceeds the 
maximum.

Up to two storages can be selected for “Set as Default 
Storage.”

4001 Invalid Value(s) for Storage Settings.
On the Anonymization Settings screen, input the 
Replace field in the specified Specific Character Set.

10028

3

User Accounts Setting Error
The User Name for User Accounts is invalid.
Includes character unsupported by the specified 
Specific Character Set.

Input the User Name of the created user account using 
only characters supported by the specified Specific 
Character Set.

104 User will be deleted. To delete the user, click OK.

202 No Essential Data Input the required items.

203
The following items are invalid.
Enter in alphanumeric.

Input the field indicated in the message using 
alphanumerics only.

205
Wrong Confirmation Password.
Enter the password again.

Input the same characters as for Password into 
Password(confirm).

208

The following item(s) is/are invalid.
- The length of User Name fields is too long. 
Shorten the total length of the 5 fields to 60 
characters or less.
- The User Name fields include characters 
unsupported by the PN type.

Input using the specific character set.

209

The following items are invalid.
Includes the character ‘\’, ‘=’, or character 
unsupported by the specified Specific Character 
Set.
[item]

306

The following item(s) is/are invalid.
- The length of User Name fields is too long. 
Shorten the total length of the 5 fields to 60 
characters or less.
- The User Name fields include characters 
unsupported by the PN type.

307

The following items are invalid.
Includes the character ‘\’, ‘=’, ‘̂ ’, or character 
unsupported by the specified Specific Character 
Set.
[item]

402
No Essential Data
[item]

Input the required items.

403
The following items are invalid.
Enter in alphanumeric.
[item]

Use alphanumerics for the input.

404
Wrong Confirmation Password.
Enter again.

Input the same characters as for Password into 
Password(confirm).

502
No Essential Data
[item]

Input the required items.

503
The following items are invalid.
Enter in alphanumeric.
[item]

Use alphanumerics for the input.
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10028

504
Wrong Old Password.
Enter the password again.

Input the registered password.

505
Wrong Confirmation Password.
Enter the password again.

Input the same characters for New Password and New 
Password(confirm).

508
New password is the same as the old password.
Enter again.

Do not input the Current Password as the New 
Password.

10031 11
Invalid Module File Combination.
To use the MPPS module, enable the worklist 
module.

When the MPPS tab (on page 107) has been set, set the 
Worklist tab (on page 104) as well.

10033 201 Print Adjustment parameters will be updated. To update the parameters, click OK.

10044

9
Association with MPPS Server was rejected.
Check the settings and status of MPPS Server.

•	 Check that the MPPS server is operating properly.

•	 Check the MPPS tab (on page 107) settings.

10
Invalid Server AE Title
Check that valid characters are entered for AE 
Title.

Check the MPPS tab (on page 107) settings.
11

Invalid Server Host Name
Check that valid characters are entered for Host 
Name.

12
Invalid Port Number
Enter a value between 1 and 65535.

10045

7
Association with Worklist Server was rejected.
Check the settings and status of Worklist Server.

•	 Check that the worklist server is operating properly.

•	 Check the Worklist tab (on page 104) settings.

8
Invalid Time
Enter a value between 1 and 24.

See “Setting the Worklist Search Conditions” (on page 
106).

9
Invalid Range of Date
Enter date values in the year 1870 or later.

10
Invalid Range of Days
Enter values between 0 and 999.

11
Invalid Worklist Search Interval.
Enter a value between 0 and 60.

12
Invalid Server AE Title
Check that valid characters are entered for AE 
Title.

See “Setting the Display Items and Worklist Server” (on 
page 105).13

Invalid Server Host Name
Check that valid characters are entered for Host 
Name.

14
Invalid Port No.
Enter a value between 1 and 65535.

16

Invalid Search Condition Value(s)
Selected item has an invalid character or the length 
is too long.
[XXXX] (DICOM TAG Name+DICOM TAG Number)

See “Setting the Worklist Search Conditions” (on page 
106).

18
The same DICOM tag is already set up for Search 
Conditions.
[XXXX] (DICOM TAG Number+DICOM TAG Name)

It is not possible to register a multiple number of the 
same DICOM tag.

19 Specified End Date is earlier than Start Date. Input a date later than the Start Date as the End Date.

20
Length of acquired worklist item is too long.
The following tag number item(s) are cut off.
[XXXX] (DICOM TAG Number+DICOM TAG Name) The transfer data of the worklist server does not meet 

the DICOM standards. Check the worklist server 
settings.21

Acquired worklist item format is invalid.
The following tag number item(s) are not acquired.
[XXXX] (DICOM TAG Number+DICOM TAG Name)

28 The specified tag for search is not supported.
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10048

1
Invalid Values for Birth Date
The entered value could not be converted to a 
birth date.

Input the correct birth date.

5
Patient Info. set as any of essential data items are 
not entered.

Input the patient information that was set in the 
essential data (on page 102).

6
The length of either of 5 Patient Name fields is too 
long.
Shorten the length to 64 characters or less.

Shorten the length to 64 characters or less.

12
The following items are invalid.
[Detailed information]

Check the details of the displayed item, and enter it 
again.

14
Invalid Study Description
Line feed code cannot be used for Study 
Description.

Delete the line feed code.

22

Invalid Accession No.
Includes ‘\’, control character, or character 
unsupported by the specified Specific Character 
Set.

Delete the backslash (\) and any control characters.

23

Invalid Patient ID
Includes ‘\’, control character, or character 
unsupported by the specified Specific Character 
Set.

24

Invalid Study Description
Includes ‘\’, line feed, control character, or 
character unsupported by the specified Specific 
Character Set.

Delete the backslash (\), line feed code and any control 
characters.

29

Invalid Patient Name
Includes one of the following:
- ‘\’, control character, or multi-byte character
- Character unsupported by the specified Specific 
Character Set
- 5 or more delimiters for the item

Delete the backslash (\) and any control characters.

39
Invalid Birth Date
The valid date ranges from a date in the year 1870 
to today.

Input an appropriate value for Birth Date.

40
Invalid Birth Date
The entered value could not be converted to a 
birth date.

50
Length of the acquired item is too long.
The following item(s) is/are cut off.

Check the information input in the magnetic card or 
barcode.

10049

7
Entered Model No. is not numeric or the value is 
out of the range between 1 and 99.

Set the model number to a number from 1 to 99.

8
Length for storage path for the study file is too 
long. Shorten to less than 80 bytes.

Set the length of the storage path to less than 80 
bytes.

22
Invalid Accession No. Includes ‘\’, control character, 
or character unsupported by the specified Specific 
Character Set. The study information in the study file (ccrhis.his) 

is invalid. Delete the backslash (\) and any control 
characters.

23
Invalid Patient ID Includes ‘\’, control character, or 
character unsupported by the specified Specific 
Character Set.

24
Invalid Study Description Includes ‘\’, line feed, 
control character, or character unsupported by the 
specified Specific Character Set.

The study information in the study file (ccrhis.his) is 
invalid. Delete the backslash (\), line feed code, and 
any control characters.
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10049

25

Invalid Patient Name
Includes one of the following:
- ‘\’, control character, or multi-byte character
- Character unsupported by the specified Specific 
Character Set
- 5 or more delimiters for the item

The study information in the study file (ccrhis.his) 
is invalid. Delete the backslash (\) and any control 
characters.

29

Invalid Referring Physician
Includes one of the following:
- ‘\’, ‘=’, control character
- Character unsupported by the specified Specific 
Character Set
- 5 or more delimiters for the item

The study information in the study file (ccrhis.his) 
is invalid. Delete the backslash (\) and any control 
characters.

39
Invalid Birth Date
The valid date ranges from a date in the year 1870 
to today. The study information in the study file (ccrhis.his) is 

invalid. Input an appropriate value for Birth Date.

40
Invalid Birth Date
The entered value could not be converted to a 
birth date.

52 Folder for study file is not set. Specify the folder to save the study file (ccrhis.his).

10050

2
Invalid Accession No.
Enter a value between 1 and 16.

Set the length limitation of the Accession No. to 16 
digits or less.

3 Character set for Accession No. is not specified. Specify the input character type.

6
Invalid Patient ID
Enter a value between 1 and 64.

Set the length limitation of the Patient ID to 64 
characters or less.

7 Character set for Patient ID is not specified.

Specify the input character type.
10 Character set for Patient Name is not specified.

11
Character set for Study Description is not 
specified.

17
Header String for Patient ID exceeds the maximum 
length.

Set the length of the Header string within the length 
limitation.

18
Invalid Patient ID
Includes the character ‘\’ or control character.

Delete the backslash (\) and any control characters.

19

Invalid Patient ID
Includes character other than the specified 
Acceptable Character Set or character unsupported 
by the specified Specific Character Set.

Input using the designated input character type or 
specific character set.

20
Header String for Accession No. exceeds the 
maximum length.

Set the length of the Header string within the length 
limitation.

21
Invalid Accession No.
Includes the character ‘\’ or control character.

Delete the backslash (\) and any control characters.

22

Invalid Accession No.
Includes character other than the specified 
Acceptable Character Set or character unsupported 
by the specified Specific Character Set.

Enter using the designated input character type or 
specific character set.

23
Header String for Study Description exceeds the 
maximum length.

Set the length of the Header string within the length 
limitation.

24
Invalid Study Description
Includes the character ‘\’ or control character.

Delete the backslash (\) and any control characters.

25

Invalid Study Description
Includes character other than the specified 
Acceptable Character Set or character unsupported 
by the specified Specific Character Set.

Enter using the designated input character type or 
specific character set.

26 Patient/Study Info. Setting Error
Set again the Patient/Study Info. based on the 
information that appears in Details.
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10051

901
The length of Patient Name fields is too long. 
Shorten the total length of the 5 fields to 60 
characters or less.

Shorten the total length of the 5 fields (Last Name, First 
Name, Middle Name, Prefix, Suffix) to 60 characters or 
less.

903 Invalid [item]
Includes the character ‘\’ or character unsupported 
by the specified Specific Character Set.

Delete the backslash (\) and any control characters.
904

905
Invalid [item]
Enter 3-digit numerics (n) and a capital Y, M, W, or 
D - in the format nnnY, nnnM, nnnW, or nnnD.

906

Invalid [item]
Includes character other than 0 to 9, ‘+’, ‘-’, ‘.’, ‘E’, 
and ‘e’ or it cannot be converted into a numeric 
value.

Try inputting again using the characters indicated in 
the message in a format valid for numerical values. 

908
Invalid [item]
Includes the character ‘\’, ‘=’, ‘̂ ’, or character 
unsupported by the specified Specific Character Set.

Delete the backslash (\) and any control characters.

10053 1000
This type of a magnetic card/bar code reader 
cannot use Connection Check function.

Check the magnetic card/barcode reader settings.

10063

1001
Enter essential data.
[item]

Input the required item that appears.

1002
Invalid [item]
Enter in numeric.

Input the displayed item in single-byte alphanumeric 
characters.

1003
Invalid [item]
Enter a value between [value 1] and [value 2].

Input the displayed item within the limitation.

1004 Entered value could not be checked.
Check the input value in the JPEG Settings screen (on 
page 88), and set it again if necessary.

1005
Entered value is not numeric or out of range.
[item]

Enter a value within the correct range for the displayed 
item.

10067

4097 Check the specified folder.
Check that there is enough space to save in the 
specified folder and that the folder can be written to.

4098
The required space to save the study exceeds the 
available disk space.

Take either of the following two measures:

•	 Change the destination to save where the available 
disk space accommodates the data to be saved.

•	 Make more available space in the disk specified for 
Destination to Save.
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Acceptable Characters

User
Login screen, User Accounts screen, Change password screen

Item
Number of
characters

Description

User ID 16 Alphanumeric characters

Password 16 Alphanumeric characters

Last Name 60 Except for =, \ and ^.

First Name 60 Except for =, \ and ^.

Middle Name 60 Except for =, \ and ^.

Prefix 60 Except for =, \ and ^.

Suffix 60 Except for =, \ and ^.

Study Input
Manual Input tab, Mag Barcode Input tab, Setting Search Condition screen of List Input tab

Item
Number of
characters

Description

Patient ID 64 Selected specific character set except for \.

Accession No. 16 Selected specific character set except for \.

Last Name * 60 Except for =, \ and ^.

First Name * 60 Except for =, \ and ^.

Middle Name * 60 Except for =, \ and ^.

Prefix * 60 Except for =, \ and ^.

Suffix * 60 Except for =, \ and ^.

Study Description 64 Selected specific character set except for \.

*  Last Name, First Name, Middle Name, Prefix, and Suffix: In Mag Barcode Input tab and Setting 
Search Condition screen, these five items are replaced by “Patient Name,” which accepts up to 64 
characters including spaces and ^.

System screen/Specific Character Set tab

Item Specific character set tag value

Default None

Latin-1 ISO_IR 100

Latin-2 ISO_IR 101

Cyrillic ISO_IR 144

Greek ISO_IR 126

Latin-5 ISO_IR 148

Japanese <katakana> ISO_IR 13

Japanese <kanji> \ISO 2022 IR 87

Japanese <kanji + katakana> ISO 2022 IR 13\ISO 2022 IR 87

Japanese <kanji + katakana (code extension)> \ISO 2022 IR 13\ISO 2022 IR 87

Japanese <katakana (code extension)> \ISO 2022 IR 13

Appendix
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DICOM settings
The items in the following table are set in the System screen, the Study Input/MPPS Modules 
screen, or a screen for setting a storage.

Item
Number of
characters

Description

Storage 64

AE Title 16 Alphanumeric characters except for \.

Station Name 16 Selected specific character set except for \.

Location 16 Selected specific character set except for \.

Institutional 
Department Name

64 Selected specific character set except for \.

Institution Name 64 Selected specific character set except for \.

Host Name 32 Alphanumeric characters except for \.

Modality 16 Alphanumeric characters except for \.

Port No. 5 digits From 1 to 65535.

Scheduled Station 
Name

16 Selected specific character set except for \.

Scheduled 
Performing 
Physician’s Name

1st: 64
2nd: 63
3rd: 63

The 1st to 3rd components are delimited by an equal sign (=).
Selected specific character set except for \.

Scheduled Location 16 Selected specific character set except for \.

Patient Name
1st: 64
2nd: 63
3rd: 63

The 1st to 3rd components are delimited by an equal sign (=).
Selected specific character set except for \.

Accession No. 16 Selected specific character set

Requested 
Procedure ID

16 Selected specific character set

File Size by Save Format

Attached digital camera: EOS 50D RETINA

L M S

JPEG 5.0 MB 3.0 MB 1.7 MB

LossLess 50.0 MB 24.0 MB 13.0 MB

* The file size depends on the subject. The sizes shown in the table are for reference only.
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Index

A
Add Patient Info. to the filename  115
AE Title  92, 105, 107, 110
Anonymization Settings  114
Arrange the thumbnail images by retinal camera mode 

(photography mode)  16
Arrange the thumbnail images by time  16
Auto Exposure for Observation  23, 98
Auto Exposure for Shoot  23, 98
Automatic Accession No. Assignation  103

B
Birth Date Input  102, 104

C
Capture Screen  49
ccrhis.his  34, 108
ccrhis.hr  34, 108
C/D Ratio – Area  57
C/D Ratio – Line  59
C/D Ratio – Vertical Line  60
Changing the save destination folder  78
COM Port  96
Connection Check  97, 99, 105, 107, 110
Convert to caret  95
Coordinate Hues  46
Create Series for Right/Left Eye  117

D
Digital Color Filter  48
Display warning when available drive size is less than  

100
Display Worklist Search window  107

E
Editing study descriptions  74
Edit List screen  79, 80, 85
Enlarge View for Focusing  98
Essential Data  102, 104

F
Filler Character  103
Full Screen  40

G
Gamma  46, 53

H
Header string  103
History List  29, 30
Hue  46, 53

I
Image comments  43
Image Property  43, 118

Image quality of JPEG images  88
Image Storage Folder  100
Import  86
Initializing the study date  72
Input Format  102
Institutional Department Name  92
Institution Name  92
Internal Fixation Lamp as Study Starts  98

J
JPEG Quality  111, 112, 113

L
Location  92
Login screen  20, 27, 91

M
Magnification  124
Magnification for the Loupe tool  124
Magnification of the observation monitor  98
Main and Thumbnails  16, 39
Modality  92
Model No.  108
MPPS Server Settings  107

N
Number of days for display on the Study Log  126
Number of displayed study logs in list  72

O
Observation monitor  64, 65, 87
Optic nerve papillary area  54
Overlay  87
Overlay Settings  116

P
Paper size  51, 52
Personal Name Conversion Rule  95
Print layout  51, 53

Q
QA parameter  47

R
Reject mark  15, 42
Resize (with fixed aspect ratio)  88, 115
RGB Channels  45

S
Save as “Image Comments”  117
Save the study file to  108
Search Conditions: DICOM Tag Keyword  106
Searches using a magnetic card/barcode reader  32
Separator between name elements  95
Series Instance UID  119
Set as Default Storage  111, 112, 113
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Set “Scheduled Performing Physician’s Name” to 
“Performing Physician’s Name”  117

Skip Study Input  38
SOP Class  92, 110, 112
SOP Instance UID  119
Station Name  92
Stereo guide mark  64, 65
Stereo mark  15, 67, 69
Storage server settings  110
Study file  34, 108
Study history file  34, 108
Study Instance UID  119
Study log mark  73
Study Result  109
Study Status  109

T
Temporarily Saved tab  71, 83
Thumbnail Order  123
Thumbnails Only  16, 39
Time-out period  116
Two-Row Thumbnails  16, 39

U
Use Guide to Capture for Stereo View  98

W
Window Center/Window Width  117
Worklist Search Interval  107
Worklist server searches  32
Worklist Server Settings  105
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